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Getting Started

Introduction
Thank you for purchasing AutoData ExpertScan. Use AutoData ExpertScan to create forms, scan
and process completed forms, and generate reports to help you analyze the information you
collect.
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About This Manual
Beyond this introduction, this manual has three chapters and a tutorial.

 Chapter 1 discusses the different elements you can use to create your forms. It also
describes how to create forms using AutoData ExpertScan features.

 Chapter 2 describes how to use AutoData ExpertScan to process and verify the data on
your completed forms. You can process data automatically with a scanner, or enter it
manually.

 Chapter 3 explains how to quickly generate four different kinds of reports to help analyze
your results: the bar graph, pie chart, trend graph and comment report.

 Chapter 4 describes how to use the Net E-nable wizard to publish your survey on the
internet and retrieve the data from completed forms.

 Tutorial instructs you on how to create a simple form in ExpertScan.
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Installing AutoData ExpertScan
 To Install AutoData ExpertScan

1. You must be logged on as an administrator to install the ExpertScan Software
2. Insert the AutoData ExpertScan CD into the CD drive of your computer.
2.  If the setup procedure doesn't start automatically, choose Run from the Start menu.
3.  Type d:setup (where d: is the letter of your CD drive) in the Open text box.
4.  Click OK.

The setup procedure guides you through the installation process. You will need to supply your
software serial number.

Note: Be sure to download and install the latest update from the AutoData website:
http://autodata.com/downloads.htm/

Note: The user must have FULL RIGHTS in the ExpertScan Progam Folder.

 

http://autodata.com/downloads.htm
http://autodata.com/downloads.htm


p10

© AutoData Systems, 2012

Opening and Exiting AutoData ExpertScan
 To launch AutoData ExpertScan 

When you installed AutoData ExpertScan, you were given the option of adding a shortcut to your
desktop. If you selected Yes, double-click on the ExpertScan icon on the desktop to open
ExpertScan.
You can also launch AutoData ExpertScan by clicking on the Start menu, then selecting
Programs | AutoData ExpertScan | ExpertScan.
The application window opens.

 To exit AutoData ExpertScan

Select Exit from the File menu, or click    in the top right corner of the application window.
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Toolbar and Status Bar
You access AutoData ExpertScan functions from the menu bar or toolbar spanning the top of the
application window. 

If desired, you can choose not to display the toolbar.
 To hide the toolbar

Choose Toolbar from the View menu.

The status bar at the bottom of the application window displays the following information: 

 The first panel displays the Form ID ; AutoData ExpertScan uses this to identify the form.
 The second panel displays the current mode, i.e., New, Empty, Locked, Report.
 The third panel displays the name and the path of the current document.
 The fourth panel displays TAB when Tabulation Rules apply.
 The fifth panel displays the currently selected Time Interval.

 To hide the status bar

Choose Statusbar from the View menu.
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AutoData ExpertScan Menus
 File Menu

Button Menu Option Function Keyboard
Shortcut

New Creates a new form. See 
Creating New Forms. Ctrl+N

Open Opens an existing form. See 
Opening Existing Forms. Ctrl+O

Save Saves the form. See Saving
Forms. Ctrl+S

Save As

Saves the current form under a
new name. See Saving Forms.
This will also assign a new Form
ID.

Export to PDF

Saves the current document as
an Adobe® PDF file. See 
Exporting Forms to PDF and
Exporting Reports to PDF.

Page Setup

Sets the form's paper size and
orientation, default spacing , and
allows you to add a footer and
change the Form ID. See 
Changing the Page Setup.

Print Prints the form. See Printing
Forms. Ctrl+P

Print Setup
Allows you to view or change
your printer setup options. See 
Printing Forms.

Print Merge
(Barcodes)

Allows you to merge data from
an Access, Excel, or text file with
a barcode field on a form. See 
Barcode Print Merge.

Ctrl+M

Export to Text File Exports form data to a text file.
See Export Data to Text File.

File list
Lists the most recently used
files; click on a file name to open
it.

Exit Closes AutoData ExpertScan.
 Edit Menu

Button Menu Option Function Keyboard
Shortcut

Cut

Removes a selected element
from a form page and copies it.
See Cutting, Copying, and
Pasting Elements.

Ctrl+X

Copy Copies a selected element from a Ctrl+C
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form page. See Cutting, Copying,
and Pasting Elements.

Paste
Pastes the cut or copied element
to the form.  See Cutting,
Copying, and Pasting Elements.

Ctrl+V

Spell Check
Runs the spell check utility on
the form's text. See Checking the
Form for Spelling Errors.

F7

Delete Comments

Deletes some or all of the
information from the comment
capture zones on a form. See 
Deleting Comments.

Clear Data
Deletes some or all processed
data from a form. See Locking
and Clearing Forms.

 View Menu
Button Menu Option Function

Toolbar
Displays and hides the toolbar at the top of
the application window. See Toolbar and
Status Bar.

Status Bar
Displays and hides the status bar at the
bottom of the application window. See Toolbar
and Status Bar.

Image Viewer Displays a preview of a scanned form. See 
Image Viewer.

Document View 

Once you have created reports for processed
data, you can switch back to the Document
View by selecting this item. See Switching
Between the Report View and the Survey
View.

First Page Move to the First Page of a multi-page
Comment Report.

Previous Page Move to the Previous Page of a multi-page
Comment Report.

Next Page Move to the Next Page of a multi-page
Comment Report.

Last Page Move to the Last Page of a multi-page
Comment Report.

Document List
Displays a list of all forms saved from the current
computer in a row and column format. See
Document List.

 Insert Menu
Button Menu Option Function

Checkmark Field Creates checkmark responses to questions or
statements. See Adding Checkmark Fields.

Handprint Field Creates boxes for handprinted responses.
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See Adding Handprint Fields.

Comment Capture
Zone

Creates areas on the form where respondents
can write freeform responses. See Adding
Comment Capture Zones.

Barcode Field Defines barcode fields on the form. See 
Adding Barcode Fields.

Key Entry Zone
Creates areas on the form where data will be
entered manually during processing. See 
Adding Key Entry Zones.

Section Header Adds a section header to the form. See 
Adding Section Headers.

Text Adds text to the form. See Adding Text.

Picture
Opens a frame into which you can load a
graphic image, such as a logo, to be displayed
on the form. See Adding Graphic Elements.

Blank Space Inserts a blank space between form elements.
See Adding Blank Spaces.

Page Break Inserts a page break. See Adding Page Breaks
.

 Process Menu

Button Menu Option Function Keyboard
Shortcut

Forms
Begins automated processing of
forms. See Automated Processing
.

F12

Manual Entry

Begins processing in manual
entry mode, i.e., you enter the
form results manually. See 
Manual Entry Mode.

F11

Import Images

Imports images scanned with
other software programs into
AutoData ExpertScan. See 
Importing Images.

Input Source
Defines the settings for the
scanner to use during processing.
See Scanner Setup.

 Report Menu
Button Menu Option Function

Bar Graph Report Creates a bar graph report of processed data.
See Creating Bar Graph Reports.

Pie Chart Report Creates a pie chart report of processed data.
See Creating Pie Chart Reports.

Trend Graph
Report

Creates a trend graph report of processed
data. See Creating Trend Graph Reports.

Comment Report Creates a comment report. See Creating
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Comment Reports.

Time Intervals

Defines the time intervals for a report. Only
data from forms processed during the
specified time interval will be included in the
report. See Setting Time Intervals.

Tabulation Rules
Specifies the conditions for including data in a
report when you want to cross-tabulate form
elements. See Cross-Tabulating Reports.

Bar Graph / Pie
Chart Options

Customizes Bar Graph and Pie Chart Reports.
See Customizing Bar Graph and Pie Chart
Reports.

Comment Report
Options

Customizes Comment Reports. See 
Customizing Comment Reports.

Save Report
Settings

Allows you to save the current Report
Settings, Tabulation Rules, Time Intervals,
Custom Report Settings, etc., for later use.
See Saving Report Settings.

Load Report
Settings

Loads previously saved report settings.  See 
Loading Report Settings.

NetE-nable Menu
Button Menu Option Function

NetE-nable Wizard
Runs the NetE-nable Wizard to Publish the
current form to the Internet. See NetE-nable
Wizard.

NetE-nable
Properties

Displays the properties of a form that was
previously published to the internet. See 
NetE-nable Properties

NetE-nable Log Displays the NetE-nable Log File. See 
NetE-nable Log

E-Mail Invitation
Wizard

Runs the E-Mail Invitation Wizard to send
e-mail invitations with a link to a previously
published document. See E-Mail Invitation
Wizard 

Barcode URL List
Wizard

Runs the Barcode URL List Wizard to generate
a list of links to a previously published
document with embedded barcode data. See
Barcode URL List Wizard

E-Mail Settings Sets the E-mail Settings for the current user.
See E-Mail Account Settings

E-Mail Log Displays the E-Mail Log See E-Mail Log

Check NetE-nable
Server for Data

Checks the NetE-nable Server for completed
form data. See Retrieving Web Data

NetE-nable
Subscription

Displays the NetE-nable Subscription Dialog
for the computer. See NetE-nable Subscription

Network Settings Displays the Network Settings Dialog Box.
See Network Settings
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NetE-nable How To Displays a brief overview of the NetE-nable
Process.

Help Menu
Button Menu Option Function

Contents Opens the Help File Table of Contents

Index Opens the Help File Index

About ExpertScan Shows the current Product Version
Information

AutoData Online
Opens AutoData Website
(http://www.autodata.com/) in the default
browser
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Creating Forms

Elements of a Form
The survey shown in the example below illustrates the elements you can add to a form with
AutoData ExpertScan. 

Note: The locators in the corners of the page are added automatically and are used by
ExpertScan while processing the form.
For the purposes of discussion, we will make a distinction between scannable elements (i.e.,
those elements that are scanned for data during processing) and non-scannable elements (e.g.,
title, footers, blank spaces, etc.).
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Scannable Form Elements
 Checkmark Field Checkmark fields are predefined or custom response options for

questions, statements, or other verbiage on a form. The respondent is instructed to place
a check, X, or hatch mark inside one or more of the circles or squares provided. There are
numerous response formats available in AutoData ExpertScan; the type of response
format chosen determines how checkmark fields are displayed on the page. See Adding
Checkmark Fields.

  Response Definition Response definitions are an optional part of the Checkmark field.
They are used to display possible responses along with their abbreviations. See Response
Definition Options.

  Handprint Field Handprint fields consist of a series of connected boxes into which
respondents print capital letters or numbers. AutoData ExpertScan converts the
handprinted information into ASCII characters, which can then be accessed for reporting
purposes. See Adding Handprint Fields.

  Comment Capture Zone Comment capture zones can be added to a form so
respondents can add handwritten comments or other information. Depending on the
processing method used for the form, the information in a comment capture zone is either
manually entered or saved as an image file. The keyed-in text or image files are displayed
directly on the report. See Adding Comment Capture Zones.

  Key Entry Zone A key entry zone is used to include data on a form that must be
handwritten by the respondents. The handwritten text is typed in manually during
processing. See Adding Key Entry Zones.

  Barcode Barcodes can be added to a form to use as unique identifiers or tracking fields
for the form, which can then be filtered for reporting purposes. For example, a barcode
could be assigned to identify patients of a specific clinic, or a particular doctor within a
clinic. See Adding Barcode Fields.

  For More Information:
Working with Element Text
 Cutting, Copying, and Pasting Elements
 Inserting Elements
 Deleting Elements
 Editing Form Elements
 Checking the Form for Spelling Errors
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Non-scannable Form Elements
 Form Title The form title appears at the top of each page between the locators. When

you create a form, you can assign to it any title you prefer. Use of a title is not required,
but is usually helpful. See Adding Form Titles.

  Locators Each page of an ExpertScan document has five locators. ExpertScan uses the
locators internally to identify the form and the page number of the scanned-in page. 

 Section Header A section header is used to visually divide different sections of a form
and, if desired, to explain the purpose of the section that follows. Section headers are
displayed on the page as white or colored text within a black or colored bar. See Adding
Section Headers.

  Text Explanatory text elements can be added to provide respondents with additional
information or instructions. See Adding Text.

  Blank Space Blank spaces can be added to a form to maintain visual balance and
readability, or to physically separate one section of the form from another. See Adding
Blank Spaces.

  Graphics AutoData ExpertScan allows you to customize your forms by inserting graphic
elements, such as pictures, logos, etc. See Adding Graphic Elements.

  Footers Footers may be added to provide additional identifying information to your
form. See Adding Footers.

  For More Information:
Working with Element Text
 Cutting, Copying, and Pasting Elements
 Inserting Elements
 Deleting Elements
 Editing Form Elements
 Checking the Form for Spelling Errors
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Creating New Forms
When you launch AutoData ExpertScan, a new form opens automatically in the application
window. You may create a form with a maximum of six pages.
 To create a new form
Click the New button in the toolbar or choose New from the File menu, or press Ctrl+N.
The new form opens in the application window. You are now ready to change the page or
formatting characteristics (if desired), and to begin adding elements to the new form.

  For More Information:
Changing the Page Setup
 Adding Scannable Elements
 Adding Non-scannable Elements
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Opening Existing Forms
When you save a form, AutoData ExpertScan adds the extension .esd. (for more information,
see Saving Forms).
 To open an existing AutoData ExpertScan form
1. Click the Open button or select Open from the File menu, or press Ctrl+O. The Open

ExpertScan File dialog box will open. 

2. Navigate to the directory where the .esd file is located.
3. Select the file you want to open from the list, or type its name in the File name: text box.
4. Click Open to open the .esd file.

You can also open a a Document from the Document List. See Document List.

ExpertScan allows you to import forms and data created in AutoData Survey, Survey Plus
and Survey Plus 2000.
Survey, Survey Plus and Survey Plus 2000 forms have the extension .sur. When you make
changes and save the form, it will be saved with the new .esd extension. 

 To open a Survey Plus 2000 form
1. Scan any existing filled-out forms into Survey, Survey Plus or Survey Plus 2000.
2. Click the Open button    (or select Open from the File menu, or press Ctrl+O). The

Open ExpertScan File dialog box displays. 
3. From the Files of type: drop-down list, select Survey Files (*.sur). 
4. Navigate to the directory where the Survey file is located.
5. Select the file you want to open from the list, or type its name in the File name: text box.
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6. Click Open. The file opens in the application window.
7. When you save the file, AutoData ExpertScan asks if you want to import the data for the

form. Click Yes to import the data.
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Changing the Page Setup
The default page setup for a new form is standard letter (8 ½" ´ 11") with a portrait (vertical)
orientation. You can change the page size and orientation, add a footer, and change the form ID
with the Page Settings dialog box.
 To change the page setup

1. Select Page Setup from the File menu, or double click on one of the Locators. The
Page Settings dialog box will open.

2.  Choose a new paper size for your form from the Paper Size list box. Options include
Letter, Legal, Half Page, A4, and Custom.

3.  If you choose Custom, adjust the values shown in the Height and Width boxes.
4.  Select the appropriate radio button to change the page orientation from Portrait

(vertical) to Landscape (horizontal).
5.  Click OK in the Page Settings dialog box to return to the form.
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Form ID
Each time you create a new form, AutoData ExpertScan assigns it a unique ID number. Normally,
you will never need to change the assigned ID. 
 To change the form ID

1. Select Page Setup from the File menu. The Page Settings dialog box will open.

2.  Click the Form ID button. The Form ID dialog box will open, showing the current form
ID and locators.

3.  Enter a new 3-digit Hexadecimal Form ID in the text box and click OK.
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Adding Form Titles
Each time you create a new form or begin a new page, the page displays the placeholder text
"Title." You can add your own title to each page.
 To add a form title

1. Double-click on the form title placeholder, or select it, right-click, and select Properties
from the pop-up menu. The Title Element Properties dialog box will open. 

2. The existing text in the text box is highlighted; type the title.
3.  Format the text.
4.  Select All Pages, This Page Only or This and All Following Pages from the Apply To

options.
5.  Click OK.
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Adding Footers
A footer displays the same information at the bottom of every page of a form. For example, you
may want to include the title of the form or your company name.
 To add a footer

1. Select Page Setup from the File menu, or double click one of the Locators to open the
Page Settings dialog box.

2.  Click the Footer button. The Footer Text dialog box will open. 

3. Type one line of footer text.
4.  Format the text. We recommend using 8 pt. type.
5.  Click OK to close the Footer Text dialog box.
6.  Click OK in the Page Settings dialog box to add the footer to the form.
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Adding Scannable Elements
Scannable elements are those elements that are scanned for data during processing. For
descriptions of the available scannable form elements, see Scannable Form Elements.
 For More Information:
Adding Barcode Fields
 Adding Checkmark Fields
 Adding Comment Capture Zones
 Adding Handprint Fields
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Adding Checkmark Fields
This section describes how to add checkmark fields with predefined response definitions. For
information on creating checkmark fields with custom response definitions, see Creating Custom
Response Definitions.
To open the Checkmark Element Properties dialog box
Click the Checkmark Field button , or select Checkmark Field from the Insert menu. The
Checkmark Element Properties dialog box will open.

The Checkmark Element Properties dialog box is used to add and edit checkmark fields. The
upper portion of the dialog box contains the text editing toolbar and the text window in which
you type and edit the text of the checkmark field. It also includes the Database Field Name and
Report Label text boxes.
The lower portion of the Checkmark Element Properties dialog box is used to define the
characteristics of the checkmark field. It includes the following items:

 the response definitions for the checkmark field
  a table describing the response options and their characteristics
  options for the placement and style of the checkmark areas
  options for displaying or hiding the response key and definition bar
  options for selecting the checkmark type
  options for numbering the question or statement
  options for showing or hiding leader dots for the question or statement
  an option to allow multiple marks

  To add a checkmark field
1. Click the Checkmark Field button , or select Checkmark Field from the Insert
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menu. The Checkmark Element Properties box opens.
2.  Type a question or statement in the text box, adjusting the font and alignment

characteristics as needed.
3.  If desired, change the Database Field Name and/or add a Report Label.
4.  Choose the Response Definition you want to use from the list on the left. The associated

responses are displayed in the Responses list box.
5.  Choose the position of the checkmark areas in the Response Position section: Right of

Question, Below Question, or Single Column.
6.  In the Response Definition section, select whether you want to display the Response

Definition Bar or the Response Key, or whether you want to Hide Both.
7.  Select the appropriate Checkmark Type to use Circles or Squares.
8.  If you want the question or statement to be numbered, select the Show Numbers

checkbox.
9.  If you want to display leader dots between the text and the response options, select the

Show Leaders checkbox.
10.  If users of the form will be allowed to choose more than one response option, select the 

Allow Multiple Marks checkbox. If respondents must select a single response option,
leave the Allow Multiple Marks checkbox unchecked.

11.  Click OK to exit the Checkmark Element Properties dialog box and add the checkmark
field to the form.
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Predefined Response Definitions
There are ten predefined response definitions, each with its own response options, as shown in
the table below. 
Note: Predefined checkmark field response definitions may not be deleted.
Response
Definition Response Options

Agree Scale Strongly Disagree / Disagree / Neutral / Agree / Strongly Agree

Good Scale Poor / Fair / Good / Very Good / Excellent

Importance Scale Not Important / Slightly Important / Important / Very Important / Essential

Male / Female Male / Female

Satisfied Scale Very Dissatisfied / Dissatisfied / Neutral / Satisfied / Very Satisfied

Time Scale None of the time / Little of the time / Some of the time / Most of the time /
All of the time

True / False True / False

True Scale Definitely False / Mostly False / Don't Know / Mostly True / Definitely True

Yes Scale Definitely No / Probably No / Don't Know / Probably Yes / Definitely Yes

Yes / No Yes / No
The response definition selected in the list determines the contents of the Responses table to its
right. 
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Response Position Options
The option selected in the Response Position section of the Checkmark Elements Properties
dialog box determines the placement of the response options relative to the question, as
illustrated below
Right of Question: 

Below Question: 

Single Column: 
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Response Definition Options
The Response Definition section of the Checkmark Element Properties dialog box
determines how the definitions for the responses are displayed on the form. 
When the Show Response Definition Bar option is selected, the response definition is fully
displayed in a bar above the question, as shown below. 

When you first add a checkmark field, this option is the default setting. Additional checkmark
fields added will have a default setting of Hide Both, until you add a different element type or
change the Response Definition your form.
If you want to display the key abbreviations (under the Key column of the Responses table) for
the response options, choose Show Response Key Only. When this option is selected, the
abbreviated response options are displayed on your form as shown below. 

To hide both the definition bar and the response keys for the response options, choose the Hide
Both option. Response options will be displayed with no definitions of the options, as shown
below. 

 



p33

© AutoData Systems, 2012

Checkmark Types
This section of the Checkmark Element Properties dialog box allows you to choose between
two different checkmark types, circles or squares, as shown below.
Circle checkmark:

Square checkmark:
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Numbers and Leaders
If you want the question or statement to be numbered, select the Show Numbers checkbox. 
If you want the response options to be preceded by leader dots, as shown in the example below,
select the Show Leaders option. Leader dots are a row of dots following the text, which lead the
eye to the response options for that question or statement.

 



p35

© AutoData Systems, 2012

Scaled, Unscaled, and Combined Response
Definitions
AutoData ExpertScan includes several predefined response sets for use with checkmark
elements. They include the Good Scale, the Satisfied Scale, and other scaled response sets. You
may also create your own custom set of responses that are scaled, unscaled, or a combination of
scaled and unscaled responses.
A scaled set of responses measures a quantity that ranges from a low value to a high value. For
example, the Good Scale measures "goodness" from a low value of "Poor" to a high value of
"Excellent." The Satisfaction Scale measures "satisfaction" from a low value of "Very dissatisfied"
to a high value of "Very satisfied." The other responses lie more or less evenly on the scale
between the lowest and highest values. Most scales include from five to seven specific responses,
or simply ask the respondent to choose a response from one to ten.
A scaled set of responses should never be set up as "multiple marks allowed." Only one choice
should be allowed for this kind of response set. It doesn’t make sense to rate something both
"Poor" and "Excellent."
A scaled response set allows the calculation of an average value. The change in the average
value, when charted over time, indicates the trend in the quantity being measured, such as
"satisfaction." For example, on average, are the respondents less or more satisfied this month
than last month?
Besides scales that indicate the respondent’s rating for a certain quantity, some other examples
of scaled response sets are age ranges, amount of time spent in the waiting room, and income
level. The common factor in these responses is that the responses lie on a line that ranges from
a low value to a high value.
An unscaled set of responses offers a choice among items that do not lie on a line from low to
high. An example of an unscaled response set would be a list of departments where the
respondents work. Other examples include a list of doctors the respondents have seen, branch
office or clinic locations, food preferences, and school subjects.
Some unscaled response sets allow the possibility that the respondent could choose more than
one response. In the examples above, the respondent may have worked in more than one
department or have seen more than one doctor. In these cases, the checkmark element should
be set up as "multiple marks allowed."
Unscaled response sets do not have an average value associated with them. It doesn’t make
sense to ask what is the "average" department or doctor chosen from the list. Since no average
exists, no trend can be shown. Therefore, a question with an unscaled response set will not show
an average (mean and standard deviation) on a bar graph or pie chart report, and no chart will
be created on the trend report.
Often a survey designer wishes to include a response such as "Not applicable" or "Don’t know"
that is not related to the other responses on the list. These types of responses do not cause a
problem if the responses are unscaled, because no average value is calculated. However, if these
responses were treated the same as the other responses in a scaled set, the average would be
incorrect. Therefore, a provision has been made in AutoData ExpertScan to allow the creation of
a scaled response set with the addition of one or more responses that are not part of the scale.
For example, the survey designer may want to use the Good Scale and include the unscaled
response "Not applicable." To create this response set, the scaled responses Poor, Fair, Good,
Very good, and Excellent are entered in the Responses Included In Scale section of the Custom
Response Editor dialog box. The response "Not applicable" is entered in the Responses Not
Included In Scale section. (See Creating Custom Response Definitions for more information.)
On the form, these six responses will appear in the normal way. On the report, however, the
"Not applicable" response will not be included in the calculation of the average value for that
element. The trend report will still track the change in the average for the scale, ignoring the
"Not applicable" responses.
Before you enter response sets in AutoData ExpertScan, determining whether the responses to a
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particular question are scaled, unscaled, or a combination of both types will result in greater
accuracy in the reports.
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Creating Custom Response Definitions
 To create a custom response definition 

1. Click the Checkmark Field button , or select Checkmark Field from the Insert
menu. The Checkmark Element Properties dialog box will open.

2.  Click the Add New button to open the Custom Response Editor dialog box. You may
create a maximum of 30 responses for each custom response definition.

3.  If the responses will be scaled for reporting purposes, click in the Response (Low to
High) column under Responses Included In Scale. If the responses will not be scaled,
click in the Response column under Responses Not Included In Scale. Type the text
of the response option.

4.  Tab to the Key column. Type a one- or two-character abbreviation for your response
option.

5.  Tab to the next row. If the response is scaled, AutoData ExpertScan automatically
assigns it a value.

6.  Repeat steps 3 through 5 to continue adding response options. 
7. Type a name in the Response Set Name text box.
8.  If necessary, use the drop-down lists at the top of the Custom Response Editor dialog

box to change the font style and size of the response options.
9.  Click OK and you will be prompted to save the new custom response definition. Click Yes

to save it and return to the Checkmark Element Properties dialog box. The custom
response definition will be added to the list of available response definitions in the 
Checkmark Element Properties dialog box so you can use it again.

10.  Click OK in the Checkmark Element Properties dialog box to add the new custom
response option to the form.

  For More Information:
Scaled, Unscaled, and Combined Response Definitions
 Editing Custom Response Definitions
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Editing Custom Response Definitions
AutoData ExpertScan comes with ten predefined response definitions. Predefined and custom
response definitions can be edited and saved with a new name.
 To edit a custom response definition

1. In the Checkmark Element Properties dialog box, select the custom response
definition you want to edit.

2.  Click the Edit button to open the Custom Response Editor.
3.  Click on the row with the item you want to change.
4.  Edit the appropriate column in the selected row.
5.  Repeat steps 3 and 4 until all required changes have been made.
6.  If you are editing a predefined response definition, you must change the name in the 

Response Set Name text box. This adds the changes as a new response set while
preserving the original response definition. If you are editing a custom response
definition, you can save the changes without changing the name to modify the original
custom response definition. Changing the name preserves the original custom response
definition and adds a new one.

7.  Click OK. When prompted to save your changes, click Yes to save the changes, exit the
Custom Response Editor and return to the Checkmark Element Properties dialog
box. or click No to exit the Custom Response Editor and return to the Checkmark
Element Properties dialog box without saving the changes.
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Adding Handprint Fields
Handprint fields require respondents to print in a series of connected boxes on the page. The
handprinted data is then read by AutoData ExpertScan during processing.
The Handprint Element Properties dialog box allows you to choose from a number of
predefined field formats. You can also create custom handprint fields. 
 To open the Handprint Element Properties dialog box

1. Click the Handprint Field button , or select Handprint Field from the Insert menu.
The Handprint Element Properties dialog box will open.

2.  Type the text of your question or statement in the text box, adjusting the font and
alignment characteristics as needed.

3.  If appropriate, change the field name and/or add a report label.
4.  If you want the handprint field to be numbered, select the Show Numbers checkbox.
5.  If you want to display leader dots between the text and the handprint field, select the 

Show Leaders checkbox.
6.  If you want to verify the data each time a form is scanned, select the Verify Always

checkbox. You should only select this option when the field is critical. This option is
typically used for Social Security Numbers, Account Numbers, etc. 

7. Under Response Position, select whether to place the response option Right of
Question or Below Question.

8.  Select a response format for the handprint field and change the number of boxes, if
needed.

9.  Click OK to add the handprint field to your form.
  For More Information:
Predefined Handprint Response Options
 Creating Variable-Length Handprint Fields
 Creating Custom Handprint Fields
 Verifying Form Data
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Predefined Handprint Response Options
The Response section in the Handprint Element Properties dialog box lists the available
predefined response options. When you select a response radio button, the handprint boxes are
displayed at the bottom of the dialog box. The Name, Address, City, State, and Company
response options can be sized as needed up to 28 characters. Change the number of boxes in the
handprint field by typing a number in the Size text box.

Handprint Response Option Format

Name

Address

City

State

Zip Code

Phone Number

Date MM/DD/YY

Date MM/DD/YYYY

Time (12 Hr.) HH:MM

Time (12 Hr.) HH:MM:SS

Time (24 Hr.) HH:MM

Time (24 Hr.) HH:MM:SS

Company

Social Security Number (SSN)

 For More Information:
Creating Variable-Length Handprint Fields
 Creating Custom Handprint Fields
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Creating Variable-Length Handprint Fields
You can use one of the five options in the Handprint Element Properties dialog box to create a
handprint field that allows more flexibility for responses. The following describes the handprint
responses.
Handprint Response Function Default Size

Alpha Allows entry of alpha characters 28

Numeric Allows entry of numeric characters 10

Alphanumeric Allows entry of both alpha and
numeric characters

10

Decimal Allows entry of numeric characters
and includes a decimal point in the
handprint field

5

 To create a variable-length handprint field
1. Click the Handprint Field button , or select Handprint Field from the Insert menu.

The Handprint Element Properties dialog box will open.
2.  Type the text of your question or statement in the text box, adjusting the font and

alignment characteristics as needed.
3.  If appropriate, change the field name and/or add a report label.
4.  Under Response Position, select whether to place the response option Right of

Question or Below Question.
5.  Select the appropriate radio button to add an Alpha, Numeric, Alphanumeric, or

Decimal handprint response.
6.  If necessary, change the number of handprint field boxes in the Size text box.
7.  Click OK to add the handprint field to the form.

         For More Information:
Predefined Handprint Response Options
 Creating Custom Handprint Fields
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Creating Custom Handprint Fields
The Custom radio button at the bottom of the Handprint Field Properties dialog box allows
entry of alphanumeric characters. You can also include other characters in the handprint field.
For example, if you want the respondent to enter a 12-digit serial number with a hyphen (-)
after the first three digits, you can include the hyphen in the handprint field. 
AutoData ExpertScan expects the letters, numbers, or characters in a handprint field to appear in
the same order every time it processes the form. The text box under the Custom radio button in
the Handprint Field Properties dialog box tells AutoData ExpertScan which combination of
characters it should expect when it reads the field. When you define a custom handprint field,
you identify the contents of each box in the field, specifying whether each box contains a letter,
a number, or a character. 
To create a custom handprint field, follow these rules:

 Type a lowercase a for the boxes that will contain a letter.
  Type a lowercase n for the boxes that will contain a number.
  If a box will ALWAYS contain the same number, symbol, or letter, type the actual

character in the box. When entering letters, always use uppercase letters.
 To illustrate, suppose your custom handprint field contains a product number that always starts
with a B, followed by two letters, three numbers, a dash, and then another letter. You would
type Baannn-a in the Handprint Field Properties dialog box, as shown below.

The custom handprint field will appear on the form as shown below.

In the example above, the uppercase B and the hyphen will always be inserted into the target
database.
Remember to type actual recurring letters as capital letters. An uppercase A means that
character is always an "A," but a lowercase a means that the entry can be any letter of the
alphabet.
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 To create a custom handprint field
1. Click the Handprint Field button , or select Handprint Field from the Insert menu.

The Handprint Element Properties dialog box will open.
2.  Type the text of your question or statement in the text box, adjusting the font and

alignment characteristics as needed.
3.  If appropriate, change the field name and/or add a report label.
4.  If you want the handprint field to be numbered, select the Show Numbers checkbox.
5.  If you want to display leader dots between the text and the handprint field, select the 

Show Leaders checkbox.
6.  If you want to verify the data each time a form is scanned, select the Verify Always

checkbox. You should only select this option when the field is critical. This option is
typically used for Social Security Numbers, Account Numbers, etc. 

7. Under Response Position, select whether to place the response option Right of
Question or Below Question.

8.  Select the Custom radio button.
9.  Click in the text box at the bottom of the Handprint Field Properties dialog box and

type the correct series of numbers, letters, and symbols, as described above. The Size
box changes accordingly.

10.  Click OK to add the custom handprint field to the form.
  For More Information:
Predefined Handprint Response Options
 Creating Variable-Length Handprint Fields
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Adding Key Entry Zones
A key entry zone is used to include data on a form that is handwritten by the respondents.
During data processing, the handwritten text is typed in verbatim, is summarized, or is coded for
cross-tabulation purposes.
 To add a key entry zone

1. Click the Key Entry Zone button , or select Key Entry Zone from the Insert menu. The
Key Entry Zone Element Properties dialog box will open. 

2. Type a label for the key entry zone in the text window.
3.  You can format the text and add a field name and report label, as described earlier in

this chapter.
4.  Click OK to add the key entry zone to the form.
5.  A key entry zone is displayed in the upper-left corner of the current page. It appears as a

box which may be resized to accommodate the amount of space needed for the response.
The box will not appear when the form is printed.

 6.        To move the key entry zone, click along the edge of the rectangle and drag it to the
proper position.
7.        Use the Grab Handles to size the box as needed.
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Adding Comment Capture Zones
Comment capture zones are rectangles on the page where respondents can write comments or
other information. If you use automated processing, the information in a comment capture zone
is saved as an image file. If you use manual entry mode to process the form, you type the
comments directly into AutoData ExpertScan. The typed text or image files are displayed directly
on comment reports.
 To add a comment capture zone

1. Click the Comment Capture Zone button , or select Comment Capture Zone from the
Insert menu. The Comment Capture Zone Element Properties dialog box will open.

2.  Type the text of your question or statement in the text box, adjusting the font and
alignment characteristics as needed.

3.  If appropriate, change the field name and/or add a report label.
4.  Select the Show Numbers checkbox if you want the comment capture zone numbered on

the form.
5.  Click OK to add the comment capture zone to your form.

6.  To resize the comment capture zone, click the bottom edge of the rectangle and drag it
to the proper height.
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Adding Barcode Fields
Barcode fields are used by ExpertScan for creating cross-tabulated reports. In order to
understand how to use barcodes, it is important to understand cross-tabulation. 
As an example, imagine that you are creating a new employee satisfaction survey and one of
your goals is to create a separate report for each department. You could have a checkmark field
where employees can check off the department they work for, but what if you have fifty
departments? The maximum number of response choices for a checkmark field is thirty. The
barcode field solves this problem. Using the above example, you could print survey forms with a
separate barcode for each department. When the forms are scanned, the barcode is read and
inserted into the database along with the rest of the form data. Afterwards, you could use
cross-tabulation rules to filter the data used to create separate reports. You could also use
comparison cross-tabulation rules to compare one department to another or one department to
all other departments as a whole. As you can see, the key to understanding how to use barcode
fields effectively is a good understanding of how the data is used within the report.
When printing forms with barcodes, you can change the barcodes and print them one at a time.
However, if you need to print forms with many different barcodes, use the print merge
capabilities of the barcode field. For more information see Barcode Print Merge.

 To add a barcode field
1. Click the Barcode Field button , or select Barcode Field from the Insert menu. The

Barcode Element Properties dialog box will open.

2.  Type the text for the Barcode. The text can be any uppercase characters A-Z, numbers
0-9 and the symbols $, %, *, +, -, ., /. Barcodes may not contain spaces. Typing
lowercase characters a-z will result in uppercase characters A-Z.

3.  If appropriate, change the field name and/or add a report label.
4.  Click OK.

  For More Information:
Barcode Print Merge
 Cross-Tabulating Reports
 Tip:   After all copies of the form have been printed with all the different barcode texts, change
the barcode(s) to text that identifies what the barcode is tracking. For example, if you are
tracking which clinic a patient visited, you might enter CLINIC as the barcode text to identify the
barcode element in the Tabulation Rules list. When the form is saved, this generic identifier will
always appear, rather than the specific clinic name typed prior to saving the form for the last
time. This will make it easier to find a particular barcode element in the Tabulation Rules list.
You do not need to print a copy of the form with the generic identifier(s).
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Adding Non-scannable Elements
Non-scannable elements are those that provide information for the respondents, but do not
include data to be scanned and reported. For a description of non-scannable elements, see 
Non-scannable Form Elements.
 For More Information:
Adding Footers
 Adding Form Titles
 Adding Blank Spaces
 Adding Graphic Elements
 Adding Page Breaks
 Adding Section Headers
 Adding Text
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Adding Section Headers
Section headers appear on forms as white or colored text inside a black or colored bar. They are
used to visually divide sections of the form and to provide details about the section to follow.
 To add a section header

1. Click the Section Header button , or select Section Header from the Insert menu. The
Section Header Element Properties dialog box will open.

2.  Type the text you want displayed in the section header.
3.  Adjust the font characteristics and alignment as needed.
4.  Choose the Font Color and Background Color.
5.  Click OK.

 Note: When choosing custom Background and Font Colors, be sure to use colors with high
contrast.
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Adding Text
You can add text to a form to provide instructions or additional information to the respondents.
 To add text 

1. Click the Text button , or select Text from the Insert menu. The Text Element
Properties dialog box will open.

2.  Adjust the font characteristics and alignment as needed.
3.  Select the Show Numbers checkbox if you want the text element numbered on the form.
4.  Click OK.
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Adding Blank Spaces
Use blank spaces to visually separate sections of your form, or to create additional room around
graphic elements. Blank spaces appear as striped rectangles in the AutoData ExpertScan
window. The striped rectangles do not appear when you print the form. 
 To add a blank space
Select Blank Space from the Insert menu. A blank space (indicated by a striped rectangle)
appears on the page.
You can adjust the size of the blank space. When you move your cursor along the bottom of the
blank space, the cursor changes to the double arrow shown below.

To change the size of the blank space, hold down the left mouse button and drag the arrow until
the blank space is the desired size.
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Adding Graphic Elements
AutoData ExpertScan allows you to add graphics to the form. AutoData ExpertScan supports
bitmap (.bmp) and JPEG (.jpg) and GIF (.gif) image files.
 To add a graphic element to your form

1. Click the Picture button , or select Picture from the Insert menu. The Open Image File
dialog box will open.

2.  Navigate to the folder where the image is saved.
3.  Select the file name from the list or type it in the File Name: text box.
4.  Click Open. The selected image displays on the currently selected page.

5.  Click in the center of the image, hold the mouse button down and drag the image where
you want to display it.

6.  Adjust the image to the appropriate size by dragging the grab handles along the bottom
and right borders with the mouse.

 Note: If you resize the image by dragging the bottom right grab handle, the aspect ratio will be
maintained. Otherwise, the image will be stretched in the direction that it is dragged.
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Adding Page Breaks
When a page break is added to a page, any elements following the break point are moved down
to the next page of the form. Forms can have a maximum of six pages.
 To add a page break
Choose Page Break from the Insert menu.
 To insert a page break between elements on a page

1. Highlight the form element you want to move to the next page.
2.  Choose Page Break from the Insert menu.

  To remove a page break
1. Click on the page break to highlight it.
2.  Right-click and select Cut from the pop-up menu.
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Changing Form Elements
You can change form elements by cutting, copying, pasting, inserting, deleting and editing the
elements. This section also describes how to use the spell check.
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Cutting, Copying, and Pasting Elements
 To cut an element
Highlight the element you want to cut and:

 right-click on the element and select Cut from the pop-up menu, or
  select Cut from the Edit menu, or
  press Ctrl+X.

 The selected element is removed from the page and placed on the Windows clipboard.
 To copy an element
Highlight the element you want to copy and: 

 right-click on the element and select Copy from the pop-up menu, or
  select Copy from the Edit menu, or
  press Ctrl+C.

 The selected element is copied and placed on the Windows clipboard.
 To paste an element

1. If you want the element pasted at the end of the form, click anywhere on the page. If you
want the element inserted before another element, select the element below the insertion
point (see Inserting Elements).

2.  To paste the element: 
 right-click on the page and select Paste from the pop-up menu, or
  select Paste from the Edit menu, or
  press Ctrl+V.

 The element is added at the insertion point.
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Inserting Elements
If no form element is selected (i.e., highlighted on the screen), AutoData ExpertScan
automatically places added elements at the end of the form. If an element other than the title is
selected, AutoData ExpertScan inserts the new element before the highlighted item. However, if
the page's title is selected, the new element is inserted immediately after the title. 
 To insert a new form element between existing elements

1. Select the element you want to appear after the new element. 
2. Click the button for the form element you want to insert, or choose the new form element

from the Insert menu.
3.  Define your new element in the Properties dialog box and click OK.
4.  The new form element is inserted before the element you selected in Step 1.
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Deleting Elements
 To delete a form element
Right-click on the element you want to delete and select Cut from the pop-up menu. The
element is deleted, and all subsequent elements until the next inserted page break (or until the
end of the document) move up. 
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Editing Form Elements
 To edit a form element's characteristics

1. Right-click on the element you want to edit. 
2. Select Properties from the pop-up menu to open the Properties dialog box for the selected

element.
3.  Edit the form element as needed, then click OK to apply the changes and return to the

page.
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Checking the Form for Spelling Errors
When you create an element, you can spell check from within the element properties dialog box.
You can also spell check an entire form at once.
 To begin spell check

1. Click the Spell Check button , or select Spell Check from the Edit menu, or press the
F7 key.

2.  The spell check begins automatically. A misspelled or unrecognized word is displayed at
the top of the dialog box, with a list of suggested changes below it.

3.  To correct the word, select one of the suggested words from the list box, or type your
own correction. Click Change to change this specific instance, or click Change All to have
the spell check make the correction whenever it encounters the word.

4.  To leave the spelling as is, click Ignore. Select Ignore All to leave the selected word
unchanged whenever it's encountered throughout the document. You can also click Add to
User Dictionary to add the unrecognized word to the spell check dictionary. This is helpful
for names and acronyms that you use frequently.

5.  A message box appears when the spell check is complete. Click OK to return to the form.
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Working with Element Text
Generally, form elements are defined in a Properties dialog box, which opens when you add a
new element. Properties dialog boxes for many elements contain additional buttons and
functions to format the text of the element you are creating or editing. 

Button Name Function

New Clears the contents of the text window. See Clearing Text
from the Properties Dialog Box.

Open Opens a Rich Text Format (.rtf) or text (.txt) document in the
text window. See Opening Rich Text Format or Text Files.

Save Saves the contents of the text window as an .rtf or .txt file.
See Saving Text as Rich Text Format or Text Files.

Cut
Removes the selected item from the text window and places it
on the Windows clipboard. See Cutting, Copying, and Pasting
Elements.

Copy Copies the selected item to the Windows clipboard. See 
Cutting, Copying, and Pasting Elements.

Paste Pastes the contents of the Windows clipboard into the text
window. See Cutting, Copying, and Pasting Elements.

Bold Applies or cancels bold formatting to selected or inserted text.
See Bolding, Italicizing, and Underlining Text.

Italic Applies or cancels italic formatting to selected or inserted
text. See Bolding, Italicizing, and Underlining Text.

Underline Applies or cancels underline formatting to selected or inserted
text. See Bolding, Italicizing, and Underlining Text.

Align Left Aligns a line of text with the left margin. See Aligning  and
Centering Text.

Center Centers a line of text. See Aligning and Centering Text.

Align
Right 

Aligns a line of text with the right margin. See Aligning and
Centering Text.
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Undo Undoes the last action taken. See Undo and Redo.

Redo Re-performs the last action taken. See Undo and Redo.

Spell
Check

Checks the spelling of all text in the text window. See Spell
Check in Properties Dialog Box.

Font Style Allows you to select a new font for the text in the text
window. See Changing Font Styles and Sizes.

Font Size Allows you to select the font size for the text in the text
window. See Changing Font Styles and Sizes.

Font Color Allows you to select a new font color from a palette, or create
a new color. See Changing Font Colors.

Backgroun
d Color

Allows you to change the Background Color. (Only available
for Section Header Elements) See Changing Background
Colors.
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Clearing Text from the Properties Dialog Box
 To clear the text from the Properties dialog box
Click the New button . This clears all of the text in the text window.
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Opening Rich Text Format or Text Files
AutoData ExpertScan allows you to open files saved in Rich Text Format (.rtf) or Text (.txt)
format in the text window. This feature saves you the work of retyping the same text on multiple
forms. 
Note: Text (.txt) files do not support formatting such as bold, underline, and italics. If you need

to format your text, save it as a Rich Text Format (.rtf) file.
 To open .rtf or text files in the text window

1. Click the Open button , or press CTRL+O. The Open Rich Text File dialog box will open.

2.  Navigate the folder where your .rtf or text file is stored.
3.  To open a text file, select TXT Files (*.txt) from the Files of type: drop-down list.
4.  Select the file name from the list of files, or type the file name in the File name: box.
5.  Click Open. The contents of the file are displayed in the text window.
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Saving Text as Rich Text Format or Text Files
You can save the contents of the text window as a Rich Text Format (.rtf) or text (.txt) file. This
feature allows you to type the text once and reuse it in another text window, or in another
application that can open these types of files. 
 To save the text window contents as an .rtf or .txt file

1. Click the Save button , or press CTRL+S. The Save Rich Text File dialog box will open.

2.  Navigate to the folder where you want to store your file.
3.  To save the file as a .txt file, select TXT Files (*.txt) from the Save as type: drop-down

list.
4.  Type a name for your file in the File name: box.
5.  Click Save.
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Cutting, Copying and Pasting Text
You can cut, copy, and paste text in the Properties dialog box. You can paste the text in the
current Properties dialog box, or the Properties dialog box for another element. 
 To cut text
Highlight the text you want to cut and click the Cut button , or press CTRL+X. The selected
text is removed from the text window and placed on the Windows clipboard.
 To copy text
Highlight the text you want to copy and click the Copy button or press CTRL+C. The selected
text is copied to the Windows clipboard.
 To paste text

1. Click the cursor where you want to insert the cut or copied text.
2.  Click the Paste button or press CTRL+V. The text is added at the insertion point.
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Bolding, Italicizing, and Underlining Text
 To bold the text in the text window
Select the text and click the Bold button , or press CTRL+B
 To italicize the text in the text window
Select the text and click the Italics button , or press CTRL+I
 To underline the text in the text window
Select the text and click the Underline button , or press CTRL+U
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Aligning and Centering Text
If you apply aligning and centering formatting characteristics, the currently selected line of text
is affected. The alignment setting remains in place until you turn it off by selecting another
alignment button.
 To align text with the left margin

1. Select the line or lines of text that you want to align left.
2.  Click the Align Left button .

  To align text with the right margin
1. Select the line or lines of text that you want to align right.
2.  Click the Align Right button .

  To center text between the margins
1. Select the line or lines of text that you want to center.
2.  Click the Center button .
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Changing Font Styles and Sizes
Changing the font style and size in the text window applies the changes to all the text in the text
window. 
 To change the font style
Select a new font name from the Font drop-down list.
 To change the font size
Select a new point size from the Size drop-down list, or highlight the number shown and type a
new number.

 



p70

© AutoData Systems, 2012

Changing Font Colors
You can select an available font color, or create a custom color. Changes to the font color apply
to all text in the text window.
 To change the font color

1. Click the Font Color button next to the Size drop-down list. The Color dialog box will
open.

2.  Choose a color from the Basic colors: palette, or select a custom color from the Custom
colors: palette.

3.  Click OK.
  To create a new custom color 

1. Click your mouse over the color hue matrix to choose your font's hue, or enter numerical
values in the Red, Green, and/or Blue boxes.

2.  Adjust the luminosity of the hue by moving the pointer up and down the slider bar, or
enter numerical values into the Hue, Saturation, and/or Luminosity boxes.

3.  When the desired color is shown in the Color/Solid box, click the Add to Custom Colors
button to display the new color in the Custom colors: palette. 
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Changing Background Colors
You can select an available background color, or create a custom color. Changes to the
background color apply to Section Headers and Scale Definition Bars of Checkmark elements. 
 To change the background color

1. Click the Background Color button next to the Size drop-down list. The Color dialog box
will open.

2.  Choose a color from the Basic colors: palette, or select a custom color from the Custom
colors: palette.

3.  Click OK.
  To create a new custom color 

1. Click your mouse over the color hue matrix to choose your font's hue, or enter numerical
values in the Red, Green, and/or Blue boxes.

2.  Adjust the luminosity of the hue by moving the pointer up and down the slider bar, or
enter numerical values into the Hue, Saturation, and/or Luminosity boxes.

3.  When the desired color is shown in the Color/Solid box, click the Add to Custom Colors
button to display the new color in the Custom colors palette. 
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Undo and Redo
AutoData ExpertScan allows you to undo the last change made within the text window. It also
allows you to redo the last action taken.
 To undo the last action taken
Click the Undo button , or press Ctrl+Z.
 To redo the last action taken
Click the Redo button , or press Ctrl+Y.
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Spell Check in Properties Dialog Box
The spell check checks the text in a Properties dialog box. When it discovers a misspelled word,
or one that it does not recognize, you can correct the word or add it to the dictionary.
 To begin spell check

1. Click the Spell Check button , or press the F7 button.

2.  The spell check begins automatically. A misspelled or unrecognized word is displayed at
the top of the dialog box, with a list of suggested changes below it.

3.  To correct the word, select one of the suggested words from the list box, or type your
own correction. Click Change to change this specific instance, or click Change All to have
the spell check make the correction whenever it encounters the word.

4.  To leave the spelling as is, click Ignore. Select Ignore All to leave the selected word
unchanged whenever it is encountered throughout the text. You can also click Add to User
Dictionary to add the unrecognized word to the spell check dictionary. This is helpful for
names and acronyms that you use frequently.

5.  A message box appears when the spell check is complete. Click OK to return to the
Properties dialog box.
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Defining Database Field Names and Report
Labels
The Properties dialog box for scannable elements allows you to define database field names and
report labels for each element. AutoData ExpertScan uses field names and report labels to
identify the elements in reports.
 Defining field names
Defining database field names applies only when you use the Access database directly. For
reporting purposes, AutoData ExpertScan automatically assigns each scannable form element a
field name. All data collected from that field is assigned to the column in the database headed by
the field name assigned to it. If required, you can change the field name associated with the field
in the Properties dialog box, thereby customizing your database column names. 
To change the field name, simply type over the name displayed in the Field Name text box.
There can be no spaces between words in the field name. You should assign names that make
your data easier to identify in the database. For example, a field called FaxNumber is easier to
identify than HandPrint3. 
 Defining report labels
If the question or statement is long and you don't want its full text printed on a report, enter a
report label. AutoData ExpertScan will display the report label on the report instead of the full
text. To add a report label, enter it in the Report Label text box.
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Saving Forms
Saving the form frequently throughout the creation process is recommended. After you have
added all of the elements to the form, you must save your work to print the form.

Important!        Always save your form before you print it to make sure the printed form
matches the final on-screen design.

 To save a form
1. Click the Save button , or select Save from the File menu, or press Ctrl+S. The Save

ExpertScan Document dialog box will open.

2.  Navigate to the folder where you want to save the form.
3.  Type the name for the form in the File name: text box.
4.  Click Save to save the form.

 When you first save a form, AutoData ExpertScan creates three different files for your form:
.esd, .frm, and .mdb, as well as a Comments folder if the form contains any comment capture
zones. The files and folder have the same name you assigned to the form. For example, if you
named the form mysurvey.esd, AutoData ExpertScan creates a mysurvey.esd file, a
mysurvey.frm file, and a mysurvey.mdb file, as well as a folder named Mysurvey Comments if
the form contains comment capture zones. Do not move .esd, .frm, and .mdb files into the
Comments folder.

 ExpertScan Document Files    These files, with the extension .esd, contain all the
elements of the form.

  Form Files     These files, with the extension .frm, are used to store the template
information for the form. The template contains information used for processing the data
on a completed form. 

 Access Database Files     Access database files, with the extension .mdb, are used to store
the processed data from completed forms. 

 TIFF Files     TIFF files, with the extension .tif, are used to store the contents of comment
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capture zones when forms are processed in automated processing mode. AutoData
ExpertScan reproduces the images of the comment capture zones directly onto reports.
TIFF files are saved in the Comments folder.

  To save an ExpertScan Document file under a new name
When you a save an ExpertScan Document file under a new name, the old .esd file remains and
ExpertScan creates new .esd, .frm, and .mdb files. However, the data files from the previous file
are not automatically copied to the new .mdb file. This means that the data contained in the
original .mbd file will not be included in reports for the new form.

1. Select Save As from the File menu. The Save ExpertScan Document dialog box will open.
2.  Navigate to the folder where you want to save the form.
3.  Type the name for the form in the File name: text box.
4.  Click Save to save the form with a new name.
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Exporting Forms to PDF
You can easily create a PDF document from any ExpertScan document. PDF files make it easy to

share files electronically via e-mail or by posting them on your on website. 

 To Create a PDF File
1. Select Export to PDF from the File Menu. The Save as PDF dialog box will open.

2.  Navigate to the folder where you want to save the form.
3.  Type the name for the form in the File name: text box.
4.  Click Save.
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Printing Forms
If you will be distributing relatively few copies of a form, you can print the final copies on a laser
printer. However, if you are distributing large numbers of a form, it makes sense to have them
printed by a professional printing facility or copy center. You may also use laser-printed masters
to create professional-quality photocopies. This section contains tips for preparing a form for
professional printing.

Before you print a form
Always test the form before distributing it! Print several copies of the form, fill them out, and
process them using automated processing mode. Then generate several reports from your test
data. This will give you an indication of how successful you were in creating the form, and how
well it will process. The test data can be deleted before scanning the real forms.

Save the ExpertScan Document 
Always save the form before you print it. If you do not save the form prior to printing, the
printed output may not match the stored template information, and AutoData ExpertScan will
not be able to process the completed forms.
 For More Information:
Printing Forms on a Laser Printer
 Printing Forms Professionally
 Print Setup
 Deleting Old Data

 



p79

© AutoData Systems, 2012

Print Setup
The Print Setup dialog box allows you to select the printer and print options for printing a form.
The Print Setup dialog box will vary depending on your printer; consult your printer
documentation for more information.
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Printing Forms on a Laser Printer
Before printing, you should make sure the print settings are correct.
Note: Remember to save your form before printing.

 To print the form
1. Click the Print button  , or select Print from the File menu, or press Ctrl+P. The

Print dialog box will open.

2.  Make sure the correct printer and properties are selected.
3.  In the Page Range section, select which page(s) of the form you want to print.
4.  Enter the number of copies you want to print.
5.  Click the Print button to print the form.
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Printing Forms Professionally
If you will be distributing large numbers of a form, you may want to have it printed at a
professional print shop or copy center. You can also use a professional printing facility if you
want to publish the form as a booklet. 
Here are some tips to achieve the best results when printing a form professionally:

 Save the ExpertScan document before you print the original. This will ensure that the
final output will match the .frm file template.

  Provide the printer with a clean, laser-printed original of the form.
  Have the forms printed on 20-pound white paper for single-sided forms, or on 24-pound

white paper for double-sided forms.
  If you use heavy stock, test it in your scanner before the forms are printed to make sure

you can process the completed forms.
  If you use colored paper, make sure you test it first. Paper that is the same color but

from different stock may scan differently.
  Make sure that the printed forms are exactly the same size as the originals. If there is

any reduction in size, the template information in the .frm file will not match the printed
forms.

  If you photocopy letter-sized pages side-by-side on 11x17" paper, score the fold dividing
the pages so they can be easily separated for scanning. Ask your printer to use
micro-perforations, and be careful when separating the pages so the paper doesn’t tear.
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Barcode Print Merge
You can select database fields and merge the data into a barcode element while printing a form.
The database file must be a Microsoft Access, Excel, or comma-delimited ASCII text file. You
can use only one data source per form.

 To merge data into a barcode element

1. Select Barcode Print Merge from the File menu, or highlight the barcode element,
right-click, and select Barcode Print Merge from the pop-menu. The Barcode Print Merge
dialog box will open. 

2. Click the Browse button and navigate to the location the data source is located.
3. If necessary, select another option from the Files of type: drop-down list.
4. Select the data source and click Open. 
5. Select the database table from the Table Name drop-down list.
6. Select the barcode for which you want to merge data from the Element Name: drop-down

list and the corresponding field name from the Column Name: drop-down list.
7. Click the Add button.
8. Repeat steps 6 and 7 for any other barcode elements on the form. Under Print Settings,

select All Records to merge all records from the data source with the form. To select a range
of records to merge, select the Records radio button and enter the range into the text boxes.
For example, enter 5 and 75 to merge records 5 through 75.

9. Click the OK button to begin printing the form with the merged data.
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Document List

The Document List displays a list of all forms saved from the current computer in a row and
column format. For each form, the list shows the date it was saved, the Form ID, and where it
was saved. The list can be sorted by any column. Any listed form can be opened by
Double-Clicking on the appropriate row.

 To Open a Document from the Document List

1. Select Document List from the View Menu.
2. Sort the list by clicking on one of the Column Headers.
3. Double-click in the Row of the File that you want to open.
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Processing Forms

Overview of Processing
When forms are processed, the data they contain is written to an Access database (.mdb) and
will be used later for reporting (see Saving Forms for details on the files created when a form is
saved).
There are two types of processing modes: Automated Processing and Manual Entry Mode.
In automated processing mode, forms are scanned by a scanner. AutoData ExpertScan reads the
incoming data from the scanner and processes it automatically. This method requires the least
amount of user input.
In manual entry mode, you type form data into AutoData ExpertScan. Manual entry mode does
not require a scanner.

You can also import images for processing.

 Date and Time Stamps
Each time a completed form is processed, its information is stamped with the date of processing
in the form's Access database. AutoData ExpertScan uses the date stamps in the Access
database to determine which data to include in a report. It is very important that your
computer's internal date and time are set correctly. You can set the date and time using
the Date/Time feature in Windows Control Panel. (for more information, see the Windows user
guide.)
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Locking and Clearing Forms
Once you have processed data for a form, the information is stored in an Access database
(.mdb). New processed data for the form is added to the Access database each time a form is
processed. Once data for a form is inserted into the Access database, the form is locked.
The only element on a locked form that can be changed is the barcode element. Barcodes are
typically changed before printing and during the Barcode Print Merge process.
You can unlock a form by clearing the form's processed data. Clearing a form erases all of the
processed data, including the image files for the comment capture zones.

 To clear and unlock a form
1. Open the form you want to clear.
2.  Select Clear Data from the Edit menu. The Clear Data dialog box will open.

3.  Select the Delete All Data checkbox and click OK.
4.  A message box will appear with a warning and the number of records that will be

deleted. Click Yes to delete the records.
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Deleting Old Data
Occasionally, you may need to delete some, but not all of your processed data. This could
happen if you distribute the same form on a regular basis. After several years, you may not need
all of the data collected earlier. 

 To delete unwanted data
1. Open the form you want to remove the data from.
2.  Select Clear Data from the Edit menu. The Clear Data dialog box will open.

3.  Select the Start Date and End Date of the data you want to delete and click OK.
4.  A message box will appear with a warning and the number of records that will be

deleted. Click Yes to delete the records.
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Deleting Comments
You can delete some or all of the comments that AutoData ExpertScan captures during
processing.

 To delete comments
1. Select Delete Comments from the Edit menu. The Clear Comments dialog box will

open.

2.  The Date Stamps fields show the earliest and last dates when comments were captured
for the form.

3.  To delete comments from a specific date range, type the dates in the Start Date and
End Date text boxes, or click on the drop-down list to select a date from the calendar.

4.  To delete all comments, select the Delete All Comments checkbox.
5.  Click OK.
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Automated Processing
Automated processing mode saves you time and money and makes gathering form data easy.
In automated processing mode, the completed forms are placed into the Automatic Document
Feeder (ADF) of a scanner connected to the system running AutoData ExpertScan. The forms are
scanned, and the images are then read and processed by AutoData ExpertScan. 
 For More Information:
Scanner Setup
 TWAIN Driver Scanners
 Scanning Forms
 Automated Processing of Multiple-Page Forms
 Automated Processing of Single-Page Forms
 Automated Processing Troubleshooting
 Verifying Form Data
 Image Viewer
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Scanner Setup
Before you begin automated processing, your scanner must be set up properly. Please install the
TWAIN driver supplied with your scanner per the scanner manufacturer’s instructions.
 For More Information:
TWAIN Driver Scanners
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TWAIN Driver Scanners
In order to use the automated processing capabilities in AutoData ExpertScan, you must first
install a TWAIN scanner driver. Most scanner manufacturers supply TWAIN drivers at no charge
when you purchase a scanner. The driver is usually shipped along with the scanner and is
installed from a CD, or the driver is available on the manufacturer’s website. Please refer to the
driver installation instructions provided with your scanner.
 To set up a TWAIN driver scanner in ExpertScan

1. Select Input Source from the Process menu. The Input Source dialog box will open.

2.  Click the TWAIN radio button.
3.  Under TWAIN settings, click the Select button. The Select Source dialog box will open.

4.  Select the scanner you want to use and click the Select button.
5.  Click the Settings button in the Input Source dialog box. The Scanner Settings dialog

box will open.
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6.  Select the Page Size from the drop-down list.
7.  Select the Resolution (300 DPI recommended).
8.  If your scanner supports dual-sided scanning and the form is printed on both sides of the

paper, select Enable Duplex Scanning.
9.  If your form consists mostly of checkmark fields (not a lot of handprint fields) you can

check Enable AutoScan. AutoScan allows the scanner to scan the next form while the
current form is still being processed. This can increase throughput if the form does not
require frequent validation.

10.  If your form is laid out in landscape, and your scanner does not support landscape mode,
check the Rotate Image 90 Degrees checkbox.

11.  Click OK to close the Scanner Settings dialog box. Click OK to close the Input Source
dialog box. You are now ready to begin processing forms with your TWAIN scanner.

 Test Button
Clicking on the Test button on the Input Source dialog box will open the scanner settings
dialog box provided by the scanner manufacturer. Each manufacturer provides different
functionality within their dialog box. It would not be practical to attempt to list all of the possible
settings, so here are some guidelines.

Setting Type Setting To Use
Mode Black & White
Dither None
DPI 300

Image Emphasis None
Noise Removal Off

White Level From White Stick
Deskew Off

Some dialog boxes provide a Scan button within their dialog box. When you click it, a page will
be scanned and displayed in the ExpertScan Image Viewer. If you have a problem with a
scanned image, you can usually isolate the problem by viewing it in the Image Viewer.

Note: If thescanned images are consistently too light or too dark, change the Brightness setting. A lower number
yields a darker image, and a higher number yields a lighter image.

Note: Many scanners are provided with both USB and SCSI interfaces. If you have a choice, AutoData recommends
using the USB interface.

Note: Scanners connected via SCSI interface require the scanner to be turned on before the computer in order for the
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computer to properly identify it.
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Scanning Forms
The file with the form you want to process must be open in the application window when
processing forms.
 To begin scanning forms in automated processing mode

1. Place the forms in the scanner's Automatic Document Feeder (ADF).

2.  Click the Automated Processing button , or select Forms from the Process menu,
or press F12.

 AutoData ExpertScan receives the image of the scanned form and looks for the locators on the
outer corners of the page. The locators, which also help AutoData ExpertScan de-skew the
images, contain a unique form ID that the software uses to determine if the form being
processed matches the form that is currently open. Once AutoData ExpertScan determines that
the form and page number are correct, the processed data is saved in an Access database.
Note: The size of the pages placed in the ADF must match the paper size specified when you set

up the scanner.
During automated processing, the Scan and Process dialog box provides information on the
progress of the processing. 

The Scan and Process dialog box shows the form ID of the form and the current page being
scanned.
 For More Information:
Automated Processing
 Automated Processing of Single-Page Forms
 Automated Processing of Multiple-Page Forms
 Automated Processing Troubleshooting
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Automated Processing of Single-Page Forms
 To automatically process single-page forms

1. Place the forms in the scanner's Automatic Document Feeder (ADF).

2.  Click the Automated Processing button , or select Forms from the Process menu,
or press F12. The Scan and Process dialog box will open, and the pages are scanned
and processed one form at a time.

3.  If any of the form's data is questionable, verify the data in the Verification Window.
4.  When all of the pages in the scanner's ADF have been scanned, place any additional

pages in the ADF and click Scan in the Scan and Process dialog box. Repeat as
necessary until all forms are processed. Click Close when you have finished processing
forms.
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Automated Processing of Multiple-Page Forms
The pages of a multiple-page form tool must be scanned in their correct order. For a three-page
form, you must first scan page 1, then page 2, then page 3 of the first form before you begin
scanning the first page of the second form. 
If the form is printed on both sides of the paper and you have a single-sided scanner, you must
scan the first side, turn the paper over, reinsert the paper in the ADF, and scan the other side. A
duplex scanner scans both sides of the sheet of paper in one pass without manual intervention.
Scanning the pages in order keeps all of the data for a form together in the Access database.
This is especially important when you are cross-tabulating data for reports. For example, the first
page of your form asks the respondents which doctor they saw. If you don't keep the pages from
the same form together, you may get page 2 results from a patient who saw "Dr. B" mixed in
with the data for a patient who saw "Dr. A."
Note: Data is written to the form's Access database only after all the pages for the form have
been processed. If you do not include all of the pages from a form, all of the data from the pages
that were processed will be discarded. The information from that form will not be included in any
reports.
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Automated Processing Troubleshooting
Forms may feed into the scanner incorrectly, or may be too damaged to be processed. In these
instances, AutoData ExpertScan displays one of the error messages in the table below. In most
cases you will be given the option to view the image. When you view the image, the problem

that caused the error is usually apparent. 
Error message Probable cause Action to take

Unable to Read Form
ID. (form may be upside

down)

AutoData ExpertScan
cannot read or find the

locators on the corners of
the page.

Check the page and
make sure the locators

are present and
undamaged. Then rescan
the page. If the locators
are damaged, the data

must be entered in
manual entry mode.

The form may have been
inserted into the ADF
backwards or upside

down.

Insert the form correctly
into the ADF and rescan

it.

The form may have been
created on a system

other than the one being
used for processing.

Enter the data in manual
entry mode.

The form may have been
printed incorrectly.

Enter the data in manual
entry mode.

The form may not have
been saved before it was

printed.

Enter the data in manual
entry mode.

Unable to process
document. Please scan
the document again.

The page was scanned
incorrectly.

Rescan the page. If the
page still cannot be

processed, enter the data
in manual entry mode.

You must open, save
and print this form In

ExpertScan before it can
be processed.

The form was printed
from Survey, Survey Plus

or Survey Plus 2000.

Open, save, and print the
form in AutoData

ExpertScan.

If these error messages persist for several pages in a row, it may be that the locators or form
elements appear in a different location on the page than is specified for the form. If this
happens, the data from the form must be entered in manual entry mode.
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Verifying Form Data
As it processes the fields on a form, AutoData ExpertScan displays any questionable characters
or marks that fall outside acceptable limits in the Verification Window. The contents of the
window will vary, depending on the field type being verified and the action needed to complete
the verification.
The Verification Window contains the entire image of the scanned form. Use the scroll bar to

view more of the page, or click in the upper right corner to maximize the window. You can
change any field on the form, not just the field presented for verification.

The Verification Window contains the following features:
 Field Name list box     The Field Name list box displays all the field names on the

displayed page. The highlighted name is the field currently displayed for verification. You
can move to any field by clicking on its name in the list box.

  Status     The status describes why a field is presented for verification.
Status Description

Low Confidence The confidence level of the field is below the acceptable
threshold.

Verify Always When the field was defined, it was assigned the attribute Verify
Always. AutoData ExpertScan always stops on a field with this

attribute so its contents can be verified.

OK The field was not assigned any attributes that would cause
AutoData ExpertScan to present it for verification, nor is the

accuracy of its data questionable. AutoData ExpertScan will not
stop on fields with this status. If you want to correct or change
information in them, select the field from the Field Name list
box, or move to the field using the Next Field or Prev Field

buttons described below.

Failure AutoData ExpertScan could not locate the field.
 Stop on LC Characters checkbox     When this option is selected, AutoData ExpertScan

highlights the first low confidence (LC) character in a handprint field. When you verify or



p98

© AutoData Systems, 2012

change a character, AutoData ExpertScan highlights the next low confidence character.
  When this option is not selected, the very first character in a handprint field is

highlighted, rather than the first low confidence character. As you verify the field, the
highlight moves sequentially through every character in the field.

  Data text box     The Data text box shows an entire field's contents. You can make
changes directly in the Data text box. This provides an alternative to
character-by-character editing, since the field's entire contents can be selected and
retyped.

  Buttons     The Verification Window has six buttons used to change the viewable area of
the page, or to move from one field to another.

Choose… To…

Next Field move to and edit the next field on the page.

Prev Field move to and edit the field prior to the currently displayed field.

Erase Field
erase all the information in the Data text box. You can either type
the correct field information in the text box or leave it blank, as

appropriate.

Zoom Out reduce the size of the page in the display, so more of it is visible.
When the image is as small as it can get, the button is disabled.

Zoom In
increase the size of the page in the display, so the details are
clearer. When the image is as large as it can get, the button is

disabled.

Close approve the contents of the fields on the current page and exit
the Verification Window.

 To verify fields in the Verification Window
1. When the Verification Window opens, it displays the first questioned field on the page.

To move to another field, click the Next Field or Prev Field button, or click the field on
the page shown, or select the field in the Field Name list box. To move to the next field,
you can also press Enter.

2.  When you reach the last field on the form, a message box asks whether you want to
verify the next form. Click Yes to verify the next scanned image, or No to return to the
Verification Window.

  For More Information:
Verifying Barcode Fields
 Verifying Checkmark Fields
 Verifying Comment Capture Zones
 Verifying Handprint Fields
 Verifying Key Entry Zones
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Verifying Checkmark Fields
During processing, AutoData ExpertScan compares the form specifications to what it finds on the
scanned form. AutoData ExpertScan presents checkmark fields for verification when more than
one checkmark is marked for a field that allows only one. (i.e., the Multiple Marks Allowed option
is not selected).

In the above example, AutoData ExpertScan presented this field for verification because the
program expected only one of the circles to be marked. The respondent made a mistake, crossed
out "Bus" and checked "Car." To the software, both of the circles appear to be marked.

 To verify a checkmark field
1. In the Verification Window, click directly on the correct response option. The information

in the Data: text box changes accordingly.
2.  Press Enter or click the Next Field button to continue verifying fields.

  For More Information:
Verifying Barcode Fields
 Verifying Comment Capture Zones
 Verifying Handprint Fields
 Verifying Key Entry Zones
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Verifying Handprint Fields
Handprint fields require verification when AutoData ExpertScan cannot recognize the
handwriting.

The Verification Window displays the original image of the handprint field with any questionable
or Low Confidence characters highlighted in dark blue. The interpreted data from the field is
shown below the original image. Any questionable characters are displayed in red. High
Confidence characters are displayed as black characters with a light blue background.
To correct data in a handprint field, you can type the correction in the verification box below the
handprint field boxes, or in the Data: text box.
Handprint fields also require verification when fields contain data in an incorrect format, for
example, when alpha characters are entered in a numeric-only field. When handprint fields
contain invalid data, the message box asks if you want to accept the invalid data.
AutoData ExpertScan is equipped with Smart Memory, which over time learns people’s hand
printing styles.

 To verify a handprint field
1. If the Stop on LC Characters checkbox is selected, the first low confidence character in

the handprint field is highlighted in the Data: text box. Type the correct character, or
press the right arrow key to accept the suggested character. The highlight skips to the
next low confidence character in the field.

2.  If the Stop on LC Characters checkbox is not selected, the first character in the field is
highlighted. Use the right arrow key to move through the characters in the field, entering
corrections as needed. When you correct a character, the highlight automatically moves
to the next character.

3.  If the handprint field contains a special character, such as the colon (:) in a Time field,
do not change the character.

4.  When you've made all the corrections, press Enter. AutoData ExpertScan continues
verifying the remaining fields.

  For More Information:
Verifying Barcode Fields
 Verifying Checkmark Fields
 Verifying Comment Capture Zones
 Verifying Key Entry Zones
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Verifying Barcode Fields
Barcode fields only require verification if they become damaged or otherwise illegible. In the
example below, the barcode field failed because the scanner was set too dark.

 To verify a barcode field
1. Type the characters of the barcode in the Data: text box. If AutoData ExpertScan cannot

read any of the characters in the barcode field, the Data: text box will be empty.
2.  Press Enter to continue verifying fields.

  For More Information:
Verifying Checkmark Fields
 Verifying Comment Capture Zones
 Verifying Handprint Fields
 Verifying Key Entry Zones
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Verifying Key Entry Zones
By definition, key entry zones require operator input. Key entry zones are completed, not
verified. When AutoData ExpertScan processes a key entry zone, the Verification Window is
displayed. 

Simply type the highlighted text into the Data: text box. You may type anything you want (up to
twenty-eight characters). You could type the initials or a numeric code instead of the highlighted
text. The key here is to be consistent. Doing so will ensure that your reports will be accurate if
you use this field when cross-tabulating.

 To complete a key entry zone
1. Type the contents of the key entry zone in the Data: text box.
2.  Press Enter to continue verifying fields.

  For More Information:
Verifying Barcode Fields
 Verifying Checkmark Fields
 Verifying Comment Capture Zones
 Verifying Handprint Fields
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Verifying Comment Capture Zones
No verification is needed for comment capture zones. In automated processing mode, AutoData
ExpertScan creates an image of the comment capture zone, if there is anything written in it, and

saves the image. 
 For More Information:
Verifying Barcode Fields
 Verifying Checkmark Fields
 Verifying Handprint Fields
 Verifying Key Entry Zones
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Importing Images
You can use AutoData ExpertScan to process images scanned in another program. The imported
image must be a TIFF file. The image may be a single-page or a multi-page file, but if it is
multi-page, the pages must be in order.
 To import images

1. Open the ExpertScan document.
2.  Select Import Images from the Process menu. The Open Image File dialog box will

open.

3.  Navigate to the directory where the .tif file is located.
4.  Select the file you want to open from the list, or type its name in the File name: text

box.
5.  Click Open to open the .tif file.
6.  The Import and Process Images dialog box will open. Each page of the image file is

processed. Once a complete set of pages has been processed, the data is written to the
database and the next page one is loaded.

7.  If an error occurs while importing an image file, an error log is generated and displayed
as a Windows Notepad document (text file). If the file cannot be loaded at all, no data will
be written to the database. If one form cannot be processed due to missing pages, pages
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out of order, etc., only the data from that form will not be written.
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Manual Entry Mode
You can process forms in manual entry mode if you do not have a scanner or if you need to
process data from damaged forms that cannot be scanned. In manual entry mode, you type
information from the completed form directly into the ExpertScan application window.
In manual entry mode, you complete the form in the application window with the responses from
completed forms. You move through the pages of the form, entering form data, until all of the
information from one completed form has been entered. AutoData ExpertScan then processes
the information and adds it to the form’s Access database.
 To start manual entry mode

1. Open the .esd file for the forms you want to process see Opening an Existing Form.
2.  Select Manual Entry from the Process menu, or press F11. The first question or

statement is highlighted in yellow.
  If the form element is a checkmark field: 
Click the appropriate circle or square directly on the screen, or press the number on the

keyboard that corresponds to the circle or square that you want to mark.
 If the form element is a handprint field:

 Type the characters from the form; they will appear as handprint boxes.
 If the form element is a comment capture zone or key entry zone:
 Type the text from the form into the comment box. Press Enter to start a new line of text.

3.        To move to the next form element, press Page Down or click on the next element. To
exit out of a comment capture zone, press Shift and Page Down.

       When you have entered all the form data, a message box appears.

4.        Click Yes to manually enter another form. Click No if you have finished. Click Cancel to
remain in the current form.

Press the Esc key at any time to exit the manual entry mode.
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Image Viewer
The Image Viewer provides a useful way to check the quality of scanned images. If you are
experiencing a high level of errors while processing, the Image Viewer may help you analyze the
problem. You can open Image Viewer any time before or during processing. The Image Viewer
displays the exact image detected by the scanner.
 To open Image Viewer
Select Image Viewer from the View menu.

 For More Information:
Image Viewer Toolbar and Menu Options
 Using Image Viewer
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Image Viewer Toolbar and Menu Options
 File Menu

Button Menu Option Function

Open Opens an image file in .tif, .bmp, or .pcx format.

Save Saves the current image.

Save As Saves the current image under a new name. 

Print Setup Allows you to view or change your printer setup options.

Print Prints the current image.

File list Lists the most recently used files; click on a file name to
open it.

Exit Closes Image Viewer.
 View Menu

Button Menu Option Function

Image
Information

Opens a dialog box that lists pertinent information (height,
width, resolution, color depth, and page number) about
the current image.

Toolbar Displays and hides the toolbar at the top of the Image
Viewer window.

Status Bar Displays and hides the status bar at the bottom of the
Image Viewer window.

Stay On Top

When this option is selected, the Image Viewer window
stays on top of any other open windows. You cannot bring
any other windows to the foreground until you turn this
option off.

 Page Menu
Button Menu Option Function

Next Page Moves to the next page of a multi-page image file.

Previous Page Moves to the previous page of a multi-page image file.

First Page Jumps to the first page of a multi-page image file.

Last Page Jumps to the last page of a multi-page image file.

Rotate Left
Rotates the image 90 degrees to the left. Selecting this
option twice rotates an upside down image to an upright
position.

Rotate Right
Rotates the image 90 degrees to the right. Selecting this
option twice rotates an upside down image to an upright
position.

Invert Turns a positive image negative or vice versa.
 Zoom Options

Button Function

Enlarges the image so less of it is visible in the Image Viewer window.

Shrinks the image so more of it is visible in the Image Viewer window.
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Lists a range of zoom sizes.
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Using Image Viewer
To use Image Viewer to analyze your scanned images, open Image Viewer and begin processing
forms in automated processing mode. What appears in the Image Viewer window is identical to
what your scanner sees. A very bright, washed-out image may indicate too high a brightness
setting on the scanner. An extremely dark image may indicate that the brightness level is set too
low. (You can adjust the brightness in the Scanner Settings dialog box in AutoData
ExpertScan.)

It is worth taking the time to adjust the settings to optimize the image in a way that is best
suited for the type of information you are gathering. For example, increasing the brightness will
help read a barcode more accurately, but may cause more errors in reading handprint fields. The

table below lists the different effects of scanner brightness on different scannable elements.
Dark vertical streaks on the image usually indicate that the scanner needs to be cleaned. Refer

to the scanner documentation for instructions on how to clean your scanner.
Data Type Darker Brightness Settings Lighter Brightness Settings

Checkmark More sensitive to marks Less sensitive to marks

Handprint More accurate recognition Less accurate recognition

Barcode More read failures More accurate

Comment Capture Zone More sensitive; better image Less sensitive; faded image

Key Entry Zone More sensitive; better image Less sensitive; faded image
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Creating Reports

Report Overview
This chapter shows you how to use the processed data from your completed forms to create bar
graphs, pie charts, trend graphs and comment reports. It also describes how to customize your
reports using specific date ranges (Time Intervals) and cross-tabulation rules. You can customize
your reports by selecting which questions to include or exclude and by adding text elements,
section headers, footers and graphic elements. In addition, you are not limited to the default
page size (8 ½ X 11). You can change the page size and even use landscape layout mode if it
better suits your needs.
If you regularly create highly customized reports or use complex tabulation rules, you can save
all of the report settings and then load them again when needed. 
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Report Types
You can create four kinds of reports in AutoData ExpertScan: bar graphs, pie charts, trend
graphs, and comment reports. In addition, you can create comparison bar graph, pie chart and
trend graphs.

 For More Information:
Creating Reports
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Bar Graphs
This report displays a bar graph for each checkmark element on the form, showing how many
responses were received for each response option. Bar graphs also provide a numeric breakdown
of the responses for each question, as well as a mean and standard deviation. 

The mean is the average response value. To calculate the mean, AutoData ExpertScan adds
together the numeric values of a question's responses and divides the total by the number of
responses received.
The standard deviation measures the dispersion of the responses above and below the mean. In
other words, it measures how much the responses vary from the average. When all of the
responses for a question are the same, the standard deviation is zero. The more the responses
vary from the mean, the higher the standard deviation.
AutoData ExpertScan does not calculate a mean or standard deviation for unscaled questions. It
wouldn't make sense, for example, to calculate a mean for a question that asks patients which
doctor they saw.
It would make sense to create a report displaying the satisfaction level of patients who saw a
particular doctor. Creating a report with this kind of information requires cross-tabulation of
responses. Data in bar graphs can be cross-tabulated to include data that fits your specific
needs. 
You can also use cross-tabulation rules to compare two sets of data. For example, you can
compare satisfaction levels at one clinic with the satisfaction levels at all clinics, as shown below.

 For More Information:
Creating Bar Graph Reports
 Comment Reports
 Pie Charts
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 Trend Graphs
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Pie Charts
Pie charts display the same information as bar graphs, only in pie chart format.

When you compare two sets of data, the report displays a pie chart for each data set.

 For More Information:
Creating Pie Chart Reports
 Bar Graphs
 Comment Reports
 Trend Graphs
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Trend Graphs
Trend graphs track the change in response values over time. Trend graphs are especially useful
for analyzing improvement or decline in satisfaction levels. To create this report, time intervals
representing different specified time periods are plotted on the graph's horizontal axis. The mean
scores for each question or statement for the time period are plotted on the graph's vertical axis.
Thus, the trend graph represents the mean score for the question or statement from one time
period to another. 

You can cross-tabulate responses for trend graphs, just as you can for bar graphs and pie charts.
For example, you may want to find out whether the satisfaction levels for patients of a particular
doctor improved over time. When you compare two sets of data, the report displays a line for
each data set.

 For More Information:
Creating Trend Graph Reports
 Bar Graphs
 Comment Reports
 Pie Charts
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Comment Reports
Comment reports display all the data in a form's comment capture zones. When forms are
processed in automated processing mode, the contents of the comment capture zones are
captured as image files and appear on the report as written. When forms are processed in
manual entry mode, the comments are displayed as typed text. You can sort comments by
respondent or by question or statement (see Customizing Comment Reports).

 For More Information:
Creating Comment Reports
 Bar Graphs
 Customizing Comment Reports
 Pie Charts
 Trend Graphs
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Report Summaries
Each time a report is generated, a Report Summary is inserted at the top of the first page of
the report. The Report Summary contains the Creation Date, Time Intervals and the Total
Respondents included in the report. You can edit this information by right-clicking on the
summary and choosing Properties from the drop-down menu.

Creation Date:        4/5/2006
Time Interval:        1/1/2004 to 4/5/2006
Total Respondents:        559
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Creating Reports
This section describes how to create bar graphs, pie charts, trend graphs and comment reports.
You can also set time intervals, define cross-tabulation rules and customize your reports.
When creating reports, you can:
Create Bar Graph Reports
 Create Pie Chart Reports
 Create Trend Graph Reports
 Create Comment Reports
 Set Time Intervals
 Cross-Tabulate the Report
  Customize Bar Graph and Pie Chart Reports (add and remove elements)
Customize Comment Reports
 Add Text
 Add Section Headers
 Add Graphic Elements
 Change the Report Title
 Add Footers
 Add Page Breaks
 Switch Between the Report View and the Survey View
 Save a Report
 Open a Saved Report
 Print the Report
 Exporting  Reports to PDF
 Save Report Settings
 Load Report Settings
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Creating Bar Graph Reports
 To create a bar graph report

1. Open the form for which you want to create a report.
2.  If you want the report to contain all of the processed data, click the Bar Graph Report

button , or select Bar Graph Report from the Report menu. Otherwise, set the Time
Intervals, Tabulation Rules, Bargraph / Piechart Report Options and click the Bar Graph
Report button , or select Bargraph Report from the Report menu.

  For More Information:
Set the time interval
 Cross-Tabulating Reports
 Changing the Report Title
 Customizing Bar Graph and Pie Chart Reports
 Creating Pie Chart Reports
 Creating Trend Graph Reports
 Creating Comment Reports
 Adding Text to a Report
 Adding Section Headers to a Report
 Switching Between the Report View and the Survey View
 Saving a Report
 Saving Report Settings
 Loading Report Settings
 Opening a Saved Report
 Printing the Report
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Creating Pie Chart Reports
 To create a pie chart report

1. Open the form for which you want to create a report. 
2. If you want the report to contain all of the processed data, click the Pie Chart Report

button , or select Pie Chart Report from the Report menu. Otherwise, set the Time
Intervals, Tabulation Rules, Bargraph / Piechart Report Options and click the Pie Chart
Report button , or select Pie Chart Report from the Report menu.

  For More Information:
Set the time interval
 Cross-Tabulating Reports
 Changing the Report Title
 Customizing Bar Graph and Pie Chart Reports
 Creating Bar Graph Reports
 Creating Trend Graph Reports
 Creating Comment Reports
 Adding Text to a Report
 Adding Section Headers to a Report
 Switching Between the Report View and the Survey View
 Saving a Report
 Saving Report Settings
 Loading Report Settings
 Opening a Saved Report
 Printing the Report
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Creating Trend Graph Reports
 To create a trend graph report

1. Open the form for which you want to create a report.
2.  Define the time intervals for the report.
3.  If you want the report to contain all of the processed data, click the Trend Graph Report

button , or select Trend Graph from the Report menu. Otherwise, Set the Time Interval
, Tabulation Rules, Bargraph / Piechart Report Options and click the Trend Graph Report
button , or select Trend Graph from the Report menu.

  For More Information:
Setting Time Intervals
Cross-Tabulating Reports
 Changing the Report Title
 Customizing Bar Graph and Pie Chart Reports
 Creating Bar Graph Reports
 Creating Pie Chart Reports
 Creating Comment Reports
 Adding Text to a Report
 Adding Section Headers to a Report
 Switching Between the Report View and the Survey View
 Saving a Report
 Saving Report Settings
 Loading Report Settings
 Opening a Saved Report
 Printing the Report
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Creating Comment Reports
1. Open the form for which you want to create a report. 
2. Select Comment Report from the Report menu.

 The report shows the contents of the comment capture zones for the form. You can set a time
interval to display comments for a specified time period, and sort comments by question or

statement, or by respondent.
 For More Information:
Customizing Comment Reports
 Deleting Comments
 Creating Bar Graph Reports
 Creating Pie Chart Reports
 Creating Trend Graph Reports
 Cross-Tabulating Reports
 Customizing Bar Graph and Pie Chart Reports
 Changing the Report Title
  Switching Between the Report View and the Survey View
Saving a Report
 Saving Report Settings
 Loading Report Settings
 Opening a Saved Report
 Printing Reports
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Switching Between the Report View and the
Document View
 To switch to the survey view
Select Document View from the View menu, or click the Document View button .
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Saving a Report
 To save a report

1. Click the Save button , or select Save from the File menu, or press Ctrl+S. The Save
ExpertScan Report dialog box will open.

2.  Navigate to the folder where you want to save the report.
3.  Type the name for the report in the File name: text box.
4.  Click Save to save the report. Reports are saved with the extension .esa.

 Note: The changes that you can make to a saved report are limited to the Title, Text and ant
Section Headers. In other words you cannot change the Time Intervals, Tab Rules,

Customization, or anything else that would affect the data. If you need to change or include new
information, create a new report.
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Exporting Reports to PDF
You can easily create a PDF document of your report. PDF files make it easy to share files
electronically via e-mail or by posting them on your on website. 

 To Create a PDF File

1. Create the report including any Tabulation Rules, Time Intervals and Customization.
2.  Select Export to PDF from the File Menu. The Save as PDF dialog box will open.

3.  Navigate to the folder where you want to save the form.
4.  Type the name for the PDF file in the File name: text box.
5.  Click Save.
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Export Data to Text File
You can export processed data to a Comma Separated Text File (CSV file) for use in other
programs.
 To Export the data to a Text File

1. Select Export to Text File from the File menu.
2.  Navigate to the folder where you want to save the text file.
3.  Type the name for the file in the File name: text box.
4.  Click Save to save the file. Text files are saved with the extension .txt.
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Saving Report Settings
ExpertScan allows you to save your report settings for later use. This is particularly handy when
you create reports with complex Tabulation Rules or Trend Graphs with many Time Intervals.

When you save report settings, the following items are saved:
 Bar Graph/Pie Chart Time Intervals
  Trend Analysis Report Time Intervals
  Report Properties, i.e., Color, 3D, Comment Order
  Tabulation Rules
  Comparison Report Tabulation Rules
  Dataset Captions
  Included/Excluded Elements

  To save report settings
1. Select Save Report Settings from the Report menu. The Save Report Settings dialog box

will open.

2.  Type a meaningful name into the Settings Name: Text box.
3.  Click the Save button.
4.  Click OK.

  For More Information:
Loading Report Settings

 Note: AutoData ExpertScan automatically saves the last used report settings with the name
"Last Used" when you close a document or exit the program.
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Opening a Saved Report
 To open a saved report

1. Click the Open button , or select Open from the File menu, or press Ctrl+O. The Open
ExpertScan File dialog box is displayed.

2.  Select ExpertScan Report (*.esa) from the Files of type: drop-down list.
3.  Navigate to the directory where the report (.esa file) is located.
4.  Select the file you want to open from the list, or type its name in the File name: text

box.
5.  Click Open to open the report.
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Loading Report Settings
ExpertScan allows you to load previously saved  report settings. This is particularly handy when
you create reports with complex Tabulation Rules or Trend Graphs with many Time Intervals.

When you save report settings, the following items are saved:
 Bar Graph/Pie Chart Time Intervals
  Trend Analysis Report Time Intervals
  Report Properties, i.e., Color, 3D, Comment Order
  Tabulation Rules
  Comparison Report Tabulation Rules
  Dataset Captions
  Included/Excluded Elements

  To load previously saved report settings
1. Select Load Report Settings from the Report menu. The Load Report Settings dialog box

will be displayed.

2.  Select the report name from the Report Settings Name list.
3.  Click OK.

  For More Information:
Saving Report Settings
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Setting Time Intervals
A time interval is defined by a start and end date. The report you create uses data collected
during the specified time interval. When a form is processed, the first item in the database
record is a date stamp recording the date when processing took place. If this date falls within the
specified time interval, the record's data is included in the report.
Note: The time interval refers to the date when a form was processed in AutoData ExpertScan,
not the date when the form was completed. Make sure your computer's date and time are set

correctly in the Date/Time feature of the Windows Control Panel.
 To set the time interval for a bar graph or pie chart report

1. Click the Time Interval button , or select Time Intervals from the Report menu.
 The Report Options dialog box will open with the Time Interval tab selected. The Date Stamps
section of the dialog box shows the earliest and latest dates that forms were processed. The
default Start Date and End Date are the first and last dates that forms were processed. You can
reset them to the default dates by clicking the Reset button.

2. To set the start date, type the date you want to use in the Start Date: text box, or click
the down arrow next to the Start Date: text box to select a date from the calendar.
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3.  To set the end date, type the date you want to use in the End Date text box, or click the
down arrow next to the End Date text box to select a date from the calendar.

4.  Click OK.
 Note: The format for the date and time shown in the Time Intervals dialog box and in reports is

determined by the Regional Settings in the Windows Control Panel.
 To set the time intervals for a trend graph report
Because trend graphs compare data over two or more time periods, you need to set at least two
time intervals for the trend graph report. A maximum of twelve time intervals may be set.

1. Click the Time Interval button , or select Time Interval from the Report menu. The
Report Options dialog box will open with the Time Intervals tab selected.

2.  In the Time Intervals for Trend Report section, set the start and end dates by typing
them in or selecting dates from the calendar.

3.  Click the Add button to add the selected time interval to the list box.
4.  Repeat steps 2 and 3 to set the additional time intervals.
5.  To delete a time interval, select it in the Time Intervals list box and click the Remove

button, or click Clear All to remove all the time intervals.
6.  To insert an earlier time interval, enter the start and end dates. Select the time interval

before which you want to include the new time interval and click the Insert button.
7.  Click OK.

 Note: There are other ways to change the date besides using the drop-down calendar. You can
simply type a different date into the list box, or select the day, month or year part of the text

and click the up-down arrow keys on the keyboard.
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Cross-Tabulating Reports
You can use cross-tabulation to constrain or filter the data used to create your reports. On a bar
graph report, for example, you can use cross-tabulation to create a report that shows only the
responses from the patients who saw a particular doctor, or only responses from those who had
an unpleasant experience with a receptionist. On a trend graph report, you may want to find out
how the patients of a particular doctor changed their perceptions of your clinic over time.
To cross-tabulate a report, you will create a set of rules that act as a filter. Only those reports
that comply with all of the rules will be included in the report. The more rules you create, the
more constrained the report will be. The tabulation rules you create apply to all ExpertScan
reports.
The cross-tabulation rules for a report are created in the Tabulation Rules tab of the Report
Options dialog box.

In the Tabulation Rules shown above, the rules indicate that the report should include the
responses from those who responded "Strongly Disagree" or "Disagree" to question #1. The
report created using these tabulation rules will still display information for all of the questions on
the form, but will only include responses for those who did not receive a friendly greeting from
the receptionist. If you view a comment report, only comments from those forms will be
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displayed. You can create a maximum of 40 tabulation rules for any data set.
You can create cross-tabulation rules for checkmark fields, handprint fields, key entry zones,
and barcode fields. You can also compare two sets of data, as described in Creating
Cross-Tabulation Rules for Comparison.
 Multiple Rules for the Same Question
If two or more rules on the Tabulation Rules list use the same question but different response
options, AutoData ExpertScan treats those rules as an "OR" statement. For example, if you
include the following two rules on your list, your report will display responses from those who did
not respond to the question with either "Strongly Disagree" or "Disagree." The "OR" operator
takes expressions that can be evaluated as true or false, and returns true if either is true, and
false if both are not true. The following is an example of what not to do, because if a person
responds "Disagree," his or her data will still be shown because the first expression evaluated as
true.
The receptionist gave me a friendly greeting <> Strongly Disagree
The receptionist gave me a friendly greeting <> Disagree
If possible, try not to use multiple rules for the same question. The two tabulation rules above
could have been accomplished with the following tabulation rule:
The receptionist gave me a friendly greeting > Disagree
 Multiple Rules for Different Questions
Multiple rules using different questions on the Tabulation Rules list will be treated as "AND"
statements. For example, if the following rules are included in your rules list, AutoData
ExpertScan will include survey data only if the survey response to the first question was
"Strongly Disagree" and if the response to the second question was "Disagree." The "AND"
operator takes expressions that can be evaluated as true or false, and returns true if both are
true, and false if both are not true.
I was very impressed with the service I received today = Strongly Disagree
The receptionist gave me a friendly greeting = Disagree
 Tabulation Rules Operators
The Operator drop-down list contains the following operators for defining which responses to
include in the report:

Operator Definition

= equal to

<> not equal to

> greater than

>= greater than or equal to

< less than

<= less than or equal to
Operators compare the relationship of two or more expressions. For example, you have a
question asking if the receptionist gave you a friendly greeting and the question has five possible
responses ranging from "Strongly Agree" to "Strongly Disagree." For this example, we want to
see the results if the question was answered "Agree." The first expression is the question itself
and the second expression is the response "Agree." The operator we want to use is "=." It would
look like this:
The receptionist gave me a friendly greeting = Agree
 For More Information:
Disabling Cross-Tabulation Rules
 Removing Cross-Tabulation Rules
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Cross-Tabulation for Checkmark Fields
 To create cross-tabulation rules for checkmark fields. 

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu. The
Report Options dialog box will open with the Tabulation Rules tab selected.

2.  Select the Enable Rules List checkbox.
3.  Select a checkmark field from the Element List: drop-down list.
4.  Select an operator from the Operator: drop-down list.
5.  Select a response for the selected question or statement from the Value: drop-down list.
6.  Click the Add button. The new rule appears in the rules list.
7.  Repeat steps 3-6 until you have added all the necessary cross-tabulation rules for

checkmark fields.
8.  If necessary, add cross-tabulation rules for handprint fields, key entry zones, and

barcode fields.
9.  Click OK.

  For More Information:
Creating Cross-Tabulation Rules for Comparison
 Disabling Cross-Tabulation Rules
 Removing Cross-Tabulation Rules
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Cross-Tabulation for Handprint Fields
You can define only one cross-tabulation rule for each handprint field question. 
 To create cross-tabulation rules for handprint fields

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu.
The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  Select the Enable Rules List checkbox.
3.  Select a handprint field from the Question List: drop-down list. 
4. Select an operator from the Operator: drop-down list. 
5. The Value: field changes from a drop-down list to a text box. Type the response you want

included in the report. For example, if you only want to include data from a specific zip
code, type the zip code.

6.  Click the Add button. The new rule displays in the rules list.
7.  Repeat steps 3-6 until you have added all the necessary cross-tabulation rules for

handprint fields.
8.  If necessary, add cross-tabulation rules for checkmark fields, key entry zones, and

barcode fields.
9.  Click OK.

  For More Information:
Creating Cross-Tabulation Rules for Comparison
 Disabling Cross-Tabulation Rules
 Removing Cross-Tabulation Rules
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Cross-Tabulation for Key Entry Zones
 To create cross-tabulation rules for Key Entry zones

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu.
The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  Select the Enable Rules List  checkbox.
3.  From the Element List: drop-down list, select the name of the key entry zone for which

you want to create a rule.
4.  Select an operator from the Operator: drop-down list.
5.  The Value: field changes from a drop-down list to a text box. Type the response you

want included in the report. For example, if you want to include data from only those
respondents who wrote "Dr. Jones" in the key entry zone, type "Dr. Jones."

6.  Click the Add button. The new rule displays in the rules list.
7.  Repeat steps 3-6 until you have added all the necessary cross-tabulation rules for key

entry zones.
8.  If necessary, add cross-tabulation rules for checkmark fields, handprint fields, and

barcode fields
9.  Click OK.

  For More Information:
Creating Cross-Tabulation Rules for Comparison

 Disabling Cross-Tabulation Rules
 Removing Cross-Tabulation Rules
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Cross-Tabulation for Barcode Fields
In the Element List, a barcode element will be identified by the word Barcode followed by the
text in the barcode element when the form was last saved.
 To create cross-tabulation rules for Barcode fields

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu.
The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  Select the Enable Rules List checkbox.
3.  Select a barcode field from the Element List: drop-down list. 
4. Select an operator from the Operator: drop-down list.
5.  The Value: field changes from a drop-down list to a text box. Type the response you

want included in the report.
6.  Click the Add button. The new rule displays in the rules list.
7.  Repeat steps 3-6 until you have added all the necessary cross-tabulation rules for

barcode fields.
8.  If necessary, add cross-tabulation rules for checkmark fields, handprint fields, and key

entry zones.
9.  Click OK.

  For More Information:
Creating Cross-Tabulation Rules for Comparison

 Disabling Cross-Tabulation Rules
 Removing Cross-Tabulation Rules
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Disabling Cross-Tabulation Rules
If you want to regenerate a report without cross-tabulation, you can disable the rules that have
been created without deleting them. 
 To disable cross-tabulation rules

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu.
The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  Deselect the Enable Rules List checkbox, i.e., click on it to remove the checkmark.
3.  Click OK.

  For More Information:
Removing Cross-Tabulation Rules
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Removing Cross-Tabulation Rules
 To remove cross-tabulation rules

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report menu.
The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  In the Rules List box, select the rule you want to delete.
3.  Click the Remove button. The selected rule is removed from the rules list.
4.  Click OK.

  For More Information:
Disabling Cross-Tabulation Rules
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Creating Cross-Tabulation Rules for Comparison
You can create tabulation rules to compare two sets of data. The responses that meet each set of
criteria are displayed in the report.

1. Click the Tabulation Rules button , or select Tabulation Rules from the Report
menu. The Report Options dialog box will open with the Tabulation Rules tab selected.

2.  In the Tabulation Rules section, create the first set of cross-tabulation rules as
described earlier in this chapter.

3.  Select the Enable Comparison Rules List checkbox.
4.  In the Tabulation Rules for Comparison section, create the second set of tabulation

rules to be used for comparison.
5.  In the DataSet1 Caption text box, type a label for the first data set on the report. For

example, if the first set of tabulation rules applies to all clinics, type All Clinics in the
DataSet1 Caption text box. The caption can be up to 11 characters long.

6.  In the DataSet2 Caption text box, type a label for the second data set on the report.
For example, if the second set of tabulation rules applies to the Eastside clinic, type 
Eastside in the DataSet2 Caption text box. The caption can be up to 11 characters
long.

7.  Click OK.
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Customizing Bar Graph and Pie Chart Reports
The Bar Graph/Pie Chart Options tab of the Report Options dialog box allows you to remove
elements from the report and change the order in which they are displayed on the report. You
can also choose to show the report in 3D and/or color. You can also add a title, text, section
headers, and graphics to the report.

 To customize a Bar Graph or Pie Chart Report
1. Click the Customize Report button , or select Bar Graph/Pie Chart Options from

the Report menu. The Report Options dialog box will open with the Bar Graph / Pie
Chart Options tab selected.

2.  The Included Elements: list box, on the left, shows all the elements in the form. To
remove an element from the report, select it in the Included Elements: list box and
click the Remove button. The selected question or statement moves to the Removed
Elements: list box.

3.  To add a removed element back to the report, select it in the Removed Elements: list
box and click the Add button. The selected element is again displayed in the Included
Elements: list box.

4.  To rearrange the order in which an element is displayed in a report, select the element in
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the Reported Elements: list box and click the Move Up or Move Down button until the
element is in the desired position.

5.  In the Report Format section, select the Show 3D and/or the Color checkboxes to
include these features in the report. 

6. Click OK. If you have already created a report, the report will be regenerated.
 Note: Press the Reset All Button at any time to set the report options back to their default

settings.
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Customizing Comment Reports
The Comment Report Options tab of the Report Options dialog box allows you to remove
comment elements from the report and change the order in which they are displayed on the
report.

 To customize a Comment Report
1. Click the Customize Report button , or select Comment Report Options from the

Report menu. The Report Options dialog box will open with the Comment Report
Options tab selected.

2.  The Included Comments: list box, on the left, shows all the comment elements in the
form. To remove an element from the report, select it in the Included Comments: list
box and click the Remove button. The comment moves to the Removed Comments: list
box.

3.  To add a removed Comment back to the report, select it in the Removed Comments:
list box and click the Add button. The selected comment is again displayed in the
Included Comments: list box.

4.  To rearrange the order in which a comment is displayed in a report, select the comment
in the Reported Comments: list box and click the Move Up or Move Down button until
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the comment is in the desired position.
5.  In the Comment Order section, select the Sort By Form or Sort By Response option.

This option determines how the comments will be displayed. For example, suppose you
have a form with three comment capture fields on it. 

       If you choose Sort By Form, the comments will be displayed on the report in their natural
order, i.e., Comment One, Comment Two, Comment Three, from the first form scanned, followed
by Comment One, Comment Two, Comment Three, from the second form scanned, etc. 
       If you choose Sort By Response, the comments will be grouped together, i.e., all of
Comment One’s comments will be displayed, followed by all of Comment Two’s, followed by all of
Comment Three’s, etc.

6. Click OK. If you have already created a comment report, the report will be re-generated.

 Note: Press the Reset All button at any time to set the comment report options back to their
default settings.

 For More Information:
Deleting Comments
 Cross-Tabulating Reports
 Changing the Report Title
  Switching Between the Report View and the Survey View
Printing Reports
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Adding Text, Section Headers, and Graphics
Elements a Report
You can change a report’s title and add other ExpertScan elements to it including text, section
headers, footers and graphic elements. Elements are added to a report the same way they are
added to a form. 
Note:        Each time the report is generated, all text, section headers, graphics and
footers are removed and the report titles are set back to default! You should add these
elements after you have set your Tabulation Rules, Time Intervals and any Customization
Settings!
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Changing the Report Title
The default title for a report is "Report Title." You can change the report title and font
characteristics.
 To change the report title

1. Double-click on the report title, or right-click on the title and select Properties from the
pop-up menu. The Title Element Properties dialog box will open.

2.  Highlight the placeholder text in the text box and type the new title.
3.  format the text as desired.
4.  Select All Pages, This Page Only or This and All Following Pages from the Apply To

options.
5.  Click OK.

  For More Information:
Adding Graphic Elements to a Report
 Adding Section Headers to a Report
 Adding Text to a Report
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Adding Text to a Report
You can add explanatory text anywhere on the report.
 To add text to a report

1. With the report open in the application window, select where you want to add the text.
The text will be inserted above the selected object. For example, to add text above a bar
graph, click the bar graph.

2.  Click the Text button , or select Text from the Insert menu. The Text Element
Properties dialog box will open.

3.  Adjust the font characteristics and alignment as needed.
4.  Type the text to appear in the report.
5.  Click OK.

  For More Information:
Adding Graphic Elements to a Report
 Adding Section Headers to a Report
 Changing the Report Title
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Adding Section Headers to a Report
You can add a section header (light text on a dark background) to a report. 
 To add a section header to a report

1. With the report open in the application window, select where you want to add the section
header. 

2. Click the Section Header button , or select Section Header from the Insert menu.
The Section Header Element Properties dialog box will open.

3.  Adjust the font characteristics and alignment as needed.
4.  Type the text to appear in the section header.
5.  Select the Font Color and Background Color.
6.  Click OK.

  For More Information:
Adding Graphic Elements to a Report
 Adding Text to a Report
 Changing the Report Title
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Adding Graphic Elements to a Report
AutoData ExpertScan allows you to add graphics to the report. AutoData ExpertScan supports
bitmap (.bmp) and JPEG (.jpg) and GIF (.gif) image files.
 To add graphics to a report

1. Click the Picture button , or select Picture from the Insert menu. The Open Image
File dialog box will open.

2.  Navigate to the folder where the image is saved.
3.  Select the file name from the list or type it in the File Name: text box.
4.  Click Open. The selected image displays on the currently selected page.

5.  Click in the center of the image, hold the mouse button down and drag the image where
you want to display it.

6.  Adjust the image to the appropriate size by dragging the grab handles along the bottom
and left borders with the mouse.

 Note: If you resize the image by dragging the bottom right grab handle, the aspect ratio will be
maintained. Otherwise, the image will be stretched in the direction that it is dragged.

 For More Information:
Adding Section Headers to a Report
 Adding Text to a Report
 Changing the Report Title
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Adding Footers to a Report
A footer displays the same information at the bottom of every page of a report. For example, you
may want to include the title of the report or your company name.
 To add a footer to a report

1. Select Page Setup from the File menu to open the Page Settings dialog box.
2.  Click the Footer button. The Footer Text dialog box will open.

3.  Type one line of footer text.
4.  Format the text. We recommend using 8 pt. type.
5.  Click OK to close the Footer Text dialog box.
6.  Click OK in the Page Settings dialog box to add the footer to the report.
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Adding Page Breaks to Reports
When a page break is added to a report, any elements following the break point are moved down
to the next page of the report. Reports can have an unlimited number of pages.
 To add a page break
Choose Page Break from the Insert menu.
 To insert a page break between elements on a report

1. Highlight the form element you want to move to the next page.
2.  Choose Page Break from the Insert menu.

  To remove a page break
1. Click on the page break to highlight it.
2.  Right-click and select Cut from the pop-up menu.
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Printing Reports
Click the Print button to send the report directly to your printer, or select Print from the File
menu, or press Ctrl+P to open the Print dialog box, where you can specify a Page Range and
Number of Copies.
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NetE-nable

NetE-nable Overview
NetE-nable allows you to create Internet versions of your ExpertScan forms and publish them on
the World Wide Web. The form and the data from completed forms are stored on the NetE-nable
server provided by AutoData Systems. 

Publishing forms is easy. Using the NetE-nable Wizard, you can publish a form to the Internet in
just a few minutes. Next, you can use the E-mail Invitation Wizard to send an e-mail to everyone
you want to complete the form, or you can post the URL link for the form to your website,
intranet, etc.

Later, you can download the data from the NetE-nable server and merge it with the data from
your scanned forms. You can then create bar graphs, pie charts, trend graphs and comment
reports exactly as you would for a scanned form.

This chapter describes how to use ExpertScan's new Internet and e-mail features.
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NetE-nable Subscription
Before you can use the NetE-nable features, you must purchase a one-year single computer
NetE-nable software license from AutoData Systems. 

Each ExpertScan installation is assigned a unique NetE-nable Subscriber ID. You must contact
AutoData Systems and provide your Subscriber ID to begin using NetE-nable.

  To start or renew a subscription

Click the NetE-nable Subscription menu item in the NetE-nable menu. 

The NetE-nable Subscription dialog box will open.

1. Click the Copy Subscriber ID button. The Subscriber ID will be copied to the Windows
clipboard. 

2. Go to your e-mail program and paste it into an e-mail addressed to sales@autodata.com or
print it out and fax it to the AutoData sales department or call the Toll Free Number in the
dialog box.

3. It usually only takes a couple of minutes to activate NetE-nable once the Subscriber ID is
received.
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Network Settings
The Network Settings dialog box provides information that ExpertScan uses to communicate
with the NetE-nable Server.

Most users will be able to publish forms to the Internet and retrieve data from their published
forms without any problems. If your computer is located behind a Firewall, you may need to
provide additional information regarding your security settings. For information on your specific
firewall, contact your network administrator.

 To open the Network Settings dialog box

Click the Network Settings menu item from the NetE-nable menu. 

The Network Settings dialog box will open.

If you want ExpertScan to attempt to detect your settings, click the Automatically detect
settings radio button (default). ExpertScan will try to determine the settings based on your web
browser settings.

To provide your settings manually, click the Use a proxy server radio button. Enter the Proxy
Server Address, Port Number, Account Name, and Password. If you do not know this
information, please contact your network administrator.

Press the Test Connection button.

ExpertScan will attempt to connect to the NetE-nable Server.

Note: It may take up to a minute to connect depending on your network, security settings,
connection speed, etc.
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The NetE-nable Wizard
The NetE-nable Wizard will walk you through the publishing process one step at a time.

 To start the NetE-nable Wizard

Click the NetE-nable Wizard menu item in the NetE-nable menu. 

The NetE-nable Wizard will open.

Click the Next button. The Wizard will display Step 1.
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The open date is the first day that the form will be accessible online. If anyone navigates to the
page before the open date, they will be redirected to an error page. 

 To set the open date

Type the date you want to use in the Open Date text box, or click the down arrow next to the
Open Date text box and select a date from the drop-down calendar.

The close date is the last day that the form will be accessible online. If anyone navigates to the
page after the close date, they will be redirected to an error page. 
 
 To set the close date

Type the date you want to use in the Close Date text box, or click the down arrow next to the
Close Date text box and select a date from the drop-down calendar.
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Note: When you need to close a previously published form immediately, set the close date to a
date earlier than today's date.

Click the Next button. The Wizard will display Step 2.

If desired, the Wizard can add an additional page at the beginning of your web form. You can use
it to display a welcome message, provide instructions or additional information to the
respondents, etc.

 To edit the welcome message

Click the Edit button. The Welcome Message dialog box will open.
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Type your welcome message. Adjust the font, font size, font color, and any additional formatting.
When finished, click OK to return to the Wizard. The welcome message will be displayed on the
page. 

Click the Next button. The Wizard will display Step 3.

If desired, the Wizard can append an additional page at the end of your web form. You can use it
to thank the respondents.

 To edit the thank you message

Click the Edit button. The Thank You Message dialog box will open.
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Type your thank you message. Adjust the font, font size, font color, and any additional
formatting. When finished, click OK to return to the wizard. The thank you message will be
displayed on the page. 

Click the Next button. The Wizard will display Step 4. 

Type your e-mail address in the text box. The NetE-nable server will use this address to notify
you, if necessary. 

Click the Next button. The Wizard will display the NetE-nable Wizard Finished screen.
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Click the Finish button to publish your form to the Internet.

If this is the first time that you have published the form, you will see a confirmation message. To
view your newly published form, click the Yes button to launch your internet browser and
navigate to it.

Click the Yes button to view your published form in your default browser.

If you have previously published this form, the Wizard will verify that you want to update it.

Note: When you update a previously published form, you will not lose any data currently
residing on the NetE-nable server, provided that you have not added or removed any
scannable elements since the form was last published. 

Changing non-scannable elements, open and close dates or welcome and thank you message
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text does not affect any data on the NetE-nable server. 

Important: If you have added or removed scannable elements since the form was last
published, any existing data residing on the NetE-nable server will be deleted. 

Specifically, the NetE-nable Wizard compares your form's current database to the previously
published database. If they are different, data residing on the NetE-nable server will be deleted.

Click the Yes button to re-publish your form.
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Retrieving Web Data
Once the respondents have filled out your form on line, you can retrieve the data from the
NetE-nable Server. ExpertScan will connect to the NetE-nable Server, validate your Subscription
ID and Survey ID, and copy the web data into your local database. The data will be in the exact
same format as scanned or manually entered data.

 To retrieve Web Data from the NetE-nable Server

1. Click the Check NetE-nable Server for Data menu item from the NetE-nable menu. 

The Retrieve Data From NetE-nable Server dialog box will open.

2. Click the Check button. A message box will display the number of records available for
download.

3. Click the Yes button to retrieve the records. The progress of the download will display in the
lower right corner of the dialog box. When all of the data has been downloaded, a message box
will display.

Note: If an error occurs during the data transfer (lost internet connection, power failure, etc.),
ExpertScan will roll back both the Web Database and the Local Database to their state before the
download was attempted. Once the error condition has been rectified, restart the download
process.
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NetE-nable Form Properties
The NetE-nable Form Properties dialog box displays information about previously published
forms.

 To view the NetE-nable Form Properties

Click the NetE-nable Properties menu item in the NetE-nable menu. 

The NetE-nable Form Properties dialog box will open.

The NetE-nable Properties tab displays the following properties:
 The Publish Date.
 The Open Date and Close Date.
 The Web ID.
 The URL address of your published form.
 The E-mail Address used to publish it. 
 The Welcome Message and Thank You Message you typed when the form was published.

Click the URL address to navigate to the published form in your Internet browser.
Click the Copy URL button to copy the URL to the Windows clipboard. This is helpful when you
want to create a link to the form on your own website or send the link in an e-mail.
Click the Welcome Message tab to display the Welcome Message. Click the Thank You
Message tab to display the Thank You Message.

Note: You cannot change any of the properties in this dialog box. If you need to make changes
to your published form, simply run the NetE-nable Wizard again.
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NetE-nable Log File
Each time you run the NetE-nable Wizard, ExpertScan writes important information to a log file
in the application folder.

 To view the NetE-nable Log File

Click the NetE-nable Log File menu item in the NetE-nable menu. 

The NetE-nable Publish Log dialog box will open.

The NetE-nable Publish Log contains the following information for each form published:

 The Form ID as Published.
 The date the form was published or updated.
 The first date the online document is/was available online.
 The last day the online document is/was available online.
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 The e-mail address used in the NetE-nable Wizard.
 A thirty-two digit alpha-numeric string of characters used by the NetE-nable Server.
 The URL Internet address of the published document.
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E-mail Account Settings
The E-mail Account dialog box provides information that the E-mail Invitation Wizard uses
to send out E-mail Invitations.

 To open the E-mail Account dialog box

Click the E-mail Settings menu item from the NetE-nable menu. 

The E-mail Account dialog box will open.

On the General Tab, enter the From Name, the From Address and the the optional Opt Out
Address.

Click on the Outgoing Server Tab.
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Enter the name of your Outgoing Server and Port Number.

If your mail server requires authentication, check the My outgoing server requires
authentication checkbox and enter your Account Name and Password.

If you want ExpertScan to remember your password (recommended), click the Remember
Password checkbox.

If you do not know this information, please contact your network administrator.

Note: Each time the E-mail Invitation Wizard sends an e-mail, it writes an entry in a log file.
Most of the time, an abbreviated entry is desirable. Click the Create a simple log file radio
button for the abbreviated log. If you have problems sending e-mail invitations, you may need to
set this option to Create a detailed log file until the problem is diagnosed.
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E-mail Invitation Wizard
You can send e-mail invitations to everyone you want to complete your published form directly
from ExpertScan with NetE-nable. You will need a file with a list of names and e-mail addresses
of the recipients. The list can be in several formats including Text File (.txt), Microsoft Excel
(.xls) or Microsoft Access (.mdb). Each e-mail will contain a link to the online version of your
document. 

If your document contains Barcode Elements, you can optionally merge additional fields from
your list into the invitation. The merged data will appear on the online form and in the
downloaded data from the form. This is very similar to the Barcode Print Merge functionality
used with printed forms. We recommend creating a test file with several Names and
corresponding E-mail addresses to test this process before proceeding with live E-mail
addresses.

Important: Before running the E-Mail Invitation Wizard you must set your e-mail account
settings in the E-Mail Account Settings dialog box. 
For more information see E-Mail Account Settings.

The E-mail invitation Wizard will walk you through the process one step at a time.

 To start the E-mail Invitation Wizard

Click the E-mail Invitation Wizard menu item in the NetE-nable menu. 

The E-mail Invitation Wizard will open.

Click the Next button. The Wizard will display Step 1.
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Type a name and a return address in the From Name and From Address text boxes. If you
want to use a separate Opt Out address, type it into the Opt Out E-mail Address text box.

Note: If you have previously entered this information in the E-mail Account Settings dialog
box, the information will be filled in for you in this step. 

Click the Next button. The Wizard will display Step 2.
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Step 2 of the Wizard displays the current E-mail Invitation. 

Click the Edit button. The Wizard will display the E-mail Invitation editor

Type a subject in the Subject: text box. 

Type your invitation in the Rich Text Editor below. Use the standard editing tools to write and
format the invitation. Place the cursor where you want the link to your online form to appear.
Click the Link Place Holder button on the Toolbar. A Link Placeholder "[LinkPlaceHolder]"
will be inserted into the invitation text. 

To include an optional Opt Out Link, type the instructions to Opt Out of receiving additional
e-mails and click the Opt Out Placeholder button on the Toolbar. An Opt Out Placeholder
"[OptOutPlaceholder]" will be inserted into the invitation text.

Click the View in Browser button to preview how your invitation will appear as an HTML e-mail
or click the Send a Test E-mail button to send an e-mail invitation to yourself.

Note: If you will use the same basic invitation for other ExpertScan documents, you can save
the invitation by clicking the Save button in the Rich Text Editor. You can then reload it using
the Open button.

When you are satisfied with the invitation, click the Ok button to return to the E-mail
Invitation Wizard.
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Click the Next button. The Wizard will display Step 3.

In this step you specify a data source that contains a list of e-mail addresses and optionally,
names and Barcode merge data.

10. Click the Browse button and navigate to the data source.
11. Select the data source and click Open. 
12. Select the database table from the Table Name drop-down list.
13. Select the E-Mail Address Field from the E-Mail Address Field drop-down list.
14. If your database contains a list of names, select the Name Field from the Name Field

drop-down list.
15. Under Records to Merge, select All Records to send an e-mail invitation to all records from

the data source. Or select a range of records by selecting the Records From radio button
and enter the range into the text boxes. For example, enter 5 and 75 to send an invitation to
the e-mail addresses in records 5 through 75.

Click the Next button. The Wizard will display Step 4.

Note: This step will be displayed only when the current ExpertScan document contains Barcode
Elements.
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Note: This is an optional step. If you have Barcode Elements on the current document you can
merge barcode data from your database into the e-mail invitation. When you do, each e-mail
recipient will receive a unique link. When the recipient uses the link to navigate to the online
document, the merged data will be placed on the form. If you skip this step, the current barcode
will be inserted. 

To merge barcode data into the invitation:

1. Select the barcode from the Barcode Name drop-down box.
2. Select the field that you want to merge from the Merge Field drop-down list.
3. Click the Add button to add the Barcode Name/Merge Field to the Barcode Name/Merge Field

List Box.

To remove an item from the Barcode Name/Merge Field List Box, click on the item and then click
the Remove button.
To remove all of the items from the Barcode Name/Merge Field List, click the Clear All button.

Click the Next button. The Wizard will display Step 5.
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This step will test the integrity of the merge database. If any problems are found, they will be
displayed in a list and must be corrected before the invitations can be sent.

Click the Next button. The Wizard will display Finished.

If the database passes the integrity check, the E-Mail Wizard Finished step will be displayed.
Otherwise, a list of data integrity errors will be displayed.
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To send the e-mail invitations to the addresses you have chosen, click the Finish button.

A message box will display the number of E-Mail Invitations sent.
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Barcode URL List Wizard
The Barcode URL List Wizard creates a list of unique URLs based on the barcode elements of the
current ExpertScan document and fields merged from a database or text file.

Like the E-Mail Invitation Wizard and the Barcode Merge Wizard, the Barcode URL List Wizard
reads data from a Text File (.txt), Microsoft Excel (.xls) or Microsoft Access (.mdb). The data
from the database field is encoded and appended to the web address of your published form.
When a respondent uses the web address to navigate to the online document, the NetE-nable
server reads it and merges it into the Barcodes on the form. Later, when you download the data,
the information is downloaded to the document database.

This is very similar to the Barcode Print Merge functionality used with printed forms. The Barcode
URL List Wizard will create a text file with a list of merged links.

The Barcode URL List Wizard will walk you through the process one step at a time.

 To start the Barcode URL List Wizard

Click the Barcode URL List Wizard menu item in the NetE-nable menu. 

The Barcode URL List Wizard will open.

Click the Next button. The Wizard will display Step 1.
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In this step you specify a data source that contains a list of barcode merge data.

16. Click the Browse button and navigate to the data source.
17. Select the Data Source and click Open. 
18. Select the database table from the Table Name drop-down list.
19. Under Records to Merge, select All Records to create a list of all records from the data

source. Or select a range of records by selecting the Records From radio button and enter
the range into the text boxes. For example, enter 5 and 75 to merge records 5 through 75.

Click the Next button. The Wizard will display Step 2.
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4. Select the Barcode from the Barcode Name drop-down box.
5. Select the field that you want to merge from the Merge Field drop-down list.
6. Click the Add button to add the Barcode/Field to the Barcode Name/Merge Field List Box.

To remove an item from the Barcode Name/Merge Field List Box, click on the item and then click
the Remove button.
To remove all of the items from the Barcode Name/Merge Field List Box, click the Clear All
button.

Click the Next button. The Wizard will display Step 3.
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This step will test the integrity of the merge database. If any problems are found, they will be
displayed in a list and must be corrected before continuing to the next step.

Click the Next button. The Wizard will display Finished.

If the database passes the integrity check, the Barcode URL Wizard Finished step will be
displayed. Otherwise, a list of data integrity errors will be displayed.
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To create the list and display the results, click the Finish button.
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Tutorial

Tutorial
This tutorial gives you an opportunity to use many of AutoData ExpertScan's functions.

 Create a form.
  Process the form in key entry mode.
  Create and print a bar graph of your processed data.

 Step 1: Start AutoData ExpertScan
 Step 2: Add a title
 Step 3: Add a footer
 Step 4: Add a text element
 Step 5: Add a section header
 Step 6: Add a checkmark field
 Step 7: Add a scaled checkmark field with a custom response definition
 Step 8: Add a handprint field
 Step 9: Add a blank space
 Step 10: Add a comment capture zone
 Step 11: Add a multiple choice checkmark field
 Step 12: Save the form
 Step 13: Print the form
 Step 14: Process the form in manual entry mode
 Step 15: Create and print a bar graph of the form results
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Step 1: Start AutoData ExpertScan
Double-click the AutoData ExpertScan icon on your desktop, or select AutoData ExpertScan
from the Start | Programs menu.
The application window opens.

Next: Add a title
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Step 2: Add a title
When you create a new form, the only items displayed on the page in the AutoData ExpertScan
window are the locators (the black boxes in the outer corners of the page) and a default title.
The locators cannot be changed, but you can add your own title.

1. Double-click "Title" to open the Title Element Properties dialog box.

2.  The default title text is highlighted. Type:
3.  Tutorial Form
4.  Select All Pages in the Applies To section.
5.  Click OK to add the new title to the form.

 Next: Add a footer
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Step 3: Add a footer
A footer displays the same information on the bottom of every page of the form. For example,
you can add a footer so your company name appears on every page.

1. Choose Page Setup from the File menu to open the Page Settings dialog box.

2.  Click the Footer button to display the Footer Text dialog box.

3.  In the text box, type:
4.  Tutorial Form Footer
5.  Click OK in the Footer Text dialog box and OK again in the Page Settings dialog box.

 The footer is added to the bottom of the form page(s). Depending on your monitor, you may
have to use the window's scroll bar to bring the footer into view.
Next: Add a text element
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Step 4: Add a text element
A text element can serve as an introduction to the form, provide instructions on how to complete
the form and so on. In this step, we will also modify the font, point size, color, and placement of
the new text element.

1. Click the Text button , or select Text from the Insert menu to display the Text Element
Properties dialog box.

2.  The placeholder text is highlighted. Type:
 Please help us improve our service by completing this short questionnaire. 

3. Change the font for the text element by selecting Times New Roman from the Font
drop-down list.

4.  Change the font size for the text element by selecting 12 from the Size drop-down list.
5.  Change the font color for the text element by clicking the Font Color button, located next

to the Size drop-down list. The Color dialog box will open.

6.  Choose a new color from the basic colors palette by clicking on a color box. Then click OK
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to apply the color to your text and return to the Text Element Properties dialog box.
7.  Center the text element by clicking the Center button , on the Text Element Properties

toolbar.
8.  Click OK to display the new text element on the form.

 Next: Add a section header
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Step 5: Add a section header
A section header divides the different sections of a form. It is displayed on the page as reversed
text (light text on a dark background).
Note: If an element is highlighted on the form, the new element is inserted before the selected

element. To add an element after existing elements, make sure that none are highlighted.
1. Click the Section Header button , or select Section Header from the Insert menu to

display the Section Header Element Properties dialog box.

2.  The placeholder text is highlighted (when reverse text is highlighted, the black
background and white text are replaced with black text on a white background). Type:

3.  Satisfaction Rating
4.  Click OK to exit the dialog box and add the section header to the form.

 Next: Add a checkmark field
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Step 6: Add a checkmark field
In a checkmark field, the person completing the form checks one or more responses to a
question or statement. A checkmark field may include responses such as Yes/No or a scale
ranging from, for example, Very Dissatisfied to Very Satisfied.

1. Click the Checkmark Field button , or select Checkmark Field from the Insert menu to
display the Checkmark Element Properties dialog box. 

2. Choose Satisfied Scale from the list of available response formats on the left of the dialog
box. The responses shown in the Responses box change accordingly.

3.  The text in the text box at the top of the dialog box is already highlighted. Type:
 How satisfied were you with your overall visit?

4. Click OK to close the Checkmark Element Properties dialog box and add the checkmark
field to the form.

 Next: Add a scaled checkmark field with a custom response definition
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Step 7: Add a scaled checkmark field with a
custom response definition
You can create your own responses for a checkmark field.

1. Click the Checkmark Field button , or select Checkmark Field from the Insert menu to
open the Checkmark Element Properties dialog box. 

2. In the text box, type:
 How convenient is our office location?

3. Under Response Definition on the right of the dialog box, select the Show Response
Definition Bar radio button so the new response definition will display on the form.

4.  Click the Add New button to open the Custom Response Editor dialog box. 

5. Click in the Responses column and type:
6.  Very Convenient
7.  Tab to the Key column and type: 

VC
8. Repeat steps 5 and 6 three more times, adding the information necessary to create the

table shown in the figure above.
9.  In the Response Set Name text box, type:

 Convenience Scale
10. Click OK in the Custom Response Editor dialog box and you will be prompted to save the

response set. Click Yes to save the response set and return to the Checkmark Element
Properties dialog box. Click OK to add the new custom response definition to the form.

 Next: Add a handprint field
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Step 8: Add a handprint field
Handprint fields contain boxes where the respondent can hand print the response. Handprint
fields are commonly used for information such as name and address, telephone number, and
social security number.

1. Click the Handprint Field button , or select Handprint Field from the Insert menu to
open the Handprint Element Properties dialog box. 

2. Highlight the placeholder text in the text box, and type:
 Please write your telephone number in the boxes below.

3. Select the Phone Number radio button in the Response section. Note the change in
appearance of the handprint boxes in the section below.

4.  Click OK to exit the Handprint Element Properties dialog box and add the new handprint
field to the form.

 Next: Add a blank space
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Step 9: Add a blank space
You can insert a blank space to visually separate sections of the form. To add a blank space,
select Blank Space from the Insert menu. A blank space, indicated by slanted green lines, is
added after the handprint field created in the previous step. The green lines will not print when
you print the form. 

 To adjust the height of the blank space element
1. Move the cursor along the bottom of the blank space until it changes to the double arrow

shown below.
2.  Hold down the left mouse button and drag the arrow until the blank space is the desired

height.

 Next: Add a comment capture zone
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Step 10: Add a comment capture zone
Comment capture zones allow respondents to handwrite comments or information when
completing the form. If you process completed forms in automated processing mode, an image
of the contents of a comment capture zone is saved in an image file. If you process completed
forms in manual entry mode, you type the contents of comment capture zones into AutoData
ExpertScan. 

1. Make sure no elements are highlighted to add the comment capture zone after the blank
space created in the previous step.

2.  Click the Comment Capture Zone button , or select Comment Capture Zone from the
Insert menu to open the Comment Capture Element Properties dialog box. 

3. The placeholder text is already highlighted. Type:
 Please write any additional comments or suggestions in the box below.

4. Click OK to add the comment capture zone to the form.
 Next: Add a multiple choice checkmark field

 



p195

© AutoData Systems, 2012

Step 11: Add a multiple choice checkmark field
In this step, you will create a checkmark field that allows multiple choices.
We want the new checkmark field to come before the handprint fields. Click the phone number
handprint field created earlier to highlight it.
Note: If a form element is highlighted when you add a new element, the new element is inserted

before the selected element. 
1. Click the Checkmark Field button , or select Checkmark Field from the Insert menu to

open the Checkmark Element Properties dialog box. 
2. Type:

 Who helped you today?
3. Click the Add New button to open the Custom Response Editor dialog box.
 Note: These responses are not scaled, so do not select the checkbox in the Scaled column.
4. Click in the Response column under Responses Not Included In Scale and type: 

Addison
5. Tab to the Key column and type:

 A
6. Repeat steps 5 and 6 to create the table shown below.

7.  In the Response Set Name text box, type:
 Sales Associates

8. Click OK in the Custom Response Editor dialog box and you will be prompted to save the
response set. Click Yes to save the response set and return to the Checkmark Field
Properties dialog box.

9.  In the Checkmark Field Properties dialog box, under Response Position, select the Below
Question radio button.

10.  Under Properties, select the Allow Multiple Marks checkbox.
11.  Click OK to add the new checkmark field.
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 Next: Save the form
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Step 12: Save the form
Note: You must save the form before printing copies of it for processing.

You have now added all of the elements for this sample form. The form should look like this:

Note: The locator boxes in the corners will appear different from the ones above. ExpertScan
assigns the three-digit Form ID that makes up the locators when the form is designed.

1. Click the Save button , in the toolbar or select Save from the File menu. The Save
ExpertScan Document dialog box will open.



p198

© AutoData Systems, 2012

2.  In the File name: text box, type:
 Tutorial

3. Click Save to save the tutorial form.
 Next: Print the form
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Step 13: Print the form
Click the Print button , in the toolbar, or select Print from the File menu. The form prints on
your default printer.
Next: Process the form in manual entry mode
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Step 14: Process the form in manual entry mode
Note: For convenience and speed, this tutorial describes only how to process your form in
manual entry mode.

1. Select Manual Entry from the Process menu or Press the F12 key. AutoData ExpertScan
displays the document with the first element highlighted, ready for you to enter a
response.

2.  Click on a response circle. An X appears in the circle.
3.  Press the Page Down key on your keyboard.
4.  Enter elements 2 and 3 in this manner. Note that you can enter more than one response

for element 3.
5.  When you reach the comment capture zone, type:

 This is my comment.
6. To continue after typing in a comment capture zone, hold down the Shift key while

pressing the Page Down key on your keyboard.
7.  When you have entered the last element on your form, AutoData ExpertScan displays a

message box that asks if you want to enter another form. Click No.
8.  The form displays in document view and is now locked.

 Next: Create and print a bar graph of the form results
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Step 15: Create and print a bar graph of the
form results

1. Click the Bar Graph button ,  or select Bar Graph Report from the Reports menu.
AutoData ExpertScan creates and displays a bar graph using the information you entered
in Step 14.

2.  Click the Print button , to print the bar graph report.
 Congratulations! You have successfully completed the AutoData ExpertScan tutorial.
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